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Welcome Welcome to the 80SJNB Jitter, Noise, BER, and Serial Data Link Analysis Software

Welcome to the 80SJNB Jitter, Noise, BER, and Serial Data Link Analysis
Software

The 80SJNB analysis software enhances the capabilities of the DSA8300 Digital Serial Analyzer. Two
versions are available: 80SJNB Essentials and 80SJNB Advanced.

80SJNB Essentials provides the following features:

Performs advanced jitter and noise analysis (RJ, DDJ, PJ, DCD, TJ@BER, and RN, DDN(high) and
DDN(low), TN@BER, vertical and horizontal eye opening at BER)

Acquires complete pattern waveform at 100 Samples/UI

Performs random and deterministic jitter analysis including BER estimation

Isolates and measures crosstalk in form of bounded uncorrelated jitter (BUJ)

Displays results graphically including histograms, spectra, and bathtub curves

Displays 2-D eye diagrams (correlated eye, probability density function (PDF) eye, and bit error
rate (BER) eye)

Saves complete acquisition results to a data file

Analysis of jitter, noise, and BER in the presence of spread spectrum clocking (SSC)

80SJNB Advanced adds:

Signal path emulation, allowing you to emulate the environment your signal encounters from the
transmitter to the receiver. Feature include:

Supports FFE and DFE equalization

Allows user-defined arbitrary filters (use for de-embedding and other applications)

Supports channel emulation (TDR/TDT and S-parameter based channel descriptions)

Other features commonly known as SDLA (Serial Data Link Analysis)

What do you want to do?

Read the product description (see page 7).

Go to Operating Basics (see page 11).
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Preface Related Documentation

Related Documentation

The following links contain other information on how to operate the oscilloscope and applications:

Relevant Web Sites (see page 3)

GPIB Information (see page 3)

Types of Online Help Information (see page 4)

GPIB Information

For information on how to operate the oscilloscope and use the application-specific GPIB commands,
refer to the following items:

The online programmers guide for your oscilloscope can provide details on how to use GPIB
commands to control the oscilloscope.

The 80SJNB remote control functions (see page 75)

Relevant Web Sites

The Tektronix Web site offers the following information:

Understanding and Characterizing Jitter Primer, literature number 55W-16146-x.

Jitter analysis details on the www.tektronix.com/jitter Web site

Information on fixture de-embedding, channel emulation, equalization, pre-emphasis, and de-emphasis
on the www.tektronix.com/sdla Web site

You can also find useful information in the Fibre Channel - Methodologies for Jitter and Signal Quality
Specification – MJSQ on the www.t11.org Web site.
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Preface Conventions

Conventions

Online help topics use the following conventions:

The terms “80SJNB application” or “application” refer to the 80SJNB Jitter, Noise and BER Analysis
software.

The term “oscilloscope” or “TekScope” refers to the product on which this application runs.

The term “select” is a generic term that applies to the two mechanical methods of choosing an option:
with a mouse or with the Touch Screen.

The term “DUT” is an abbreviation for Device Under Test.

When steps require a sequence of selections using the application interface, the “>” delimiter marks
each transition between a menu and an option. For example, one of the steps to recall a setup file
would appear as File > Recall Settings.

Types of Online Help Information

The online help contains the following topics:

Getting Started topics briefly describes the application and its requirements.

Operating Basics topics cover basic operating principles of the application. The sequence of topics
reflects the steps you perform to operate the application.

Parameters topics cover the Analysis and Configuration default settings.

Application Examples topics show how to use jitter measurements to identify a problem with a
waveform. This should give you ideas on how to solve your own measurement problems.

GPIB Command Syntax topics contain a list of arguments and values that you can use with the remote
commands and their associated parameters.

See Also:

Using Online Help (see page 5)
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Preface Online Help Use

Online Help Use

Online help has many advantages over a printed manual because of advanced search capabilities. The
main (opening) Help screen shows a series of book icons and three tabs along the top menu, each of
which offers a unique mode of assistance:

Contents tab - organizes the Help into book-like sections. Select a book icon to open a section;
select any of the topics listed under the book.

Index tab - enables you to scroll a list of alphabetical keywords. Select the topic of interest to display
the corresponding help page.

Search tab - enables you to search the entire help contents for keywords. Select the topic of interest to
display the corresponding help page. Search results do not include text contained within illustrations
or screen shots.

NOTE. Blue-underlined text indicates a hyperlink to another topic. For example, select the blue text to
jump to the topic on Feedback to Tektronix. (see page 6)

TIP. When you use a mouse, the normal cursor changes to a link cursor when over an active hyperlink.
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Preface Feedback

Feedback

Tektronix values your feedback on our products. To help us serve you better, please send us suggestions,
ideas, or other comments you may have about your application or oscilloscope. Send your feedback to
techsupport@tektronix.

Please be as specific as possible and include the following information:

General Information

Oscilloscope model number, firmware version number, and hardware/software options, if any.

Module and probe configuration. Include model numbers and the channel/slot location.

Serial data standard.

Signaling rate.

Pattern type and length.

Your name, company, mailing address, phone number, FAX number.

NOTE. Please indicate if you would like Tektronix to contact you regarding your suggestion or comments.

Application-Specific Information

80SJNB Software version number.

Description of the problem such that technical support can duplicate the problem.

If possible, save the oscilloscope waveform file as a .wfm file.

If possible, save the 80SJNB data to a .mat file (File > Save Data).

If possible, save the 80SJNB and oscilloscope settings to a .stp file (File > Save Settings).

Once you have gathered this information, contact technical support by phone or through email. If using
email, be sure to enter “80SJNB Problem” in the subject line, and attach the .stp and .wfm files.
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Getting Started Product Description

Product Description

The 80SJNB software application enhances the capabilities of the DSA8300 Digital Serial Analyzer by
providing Jitter, Noise, and BER analysis (Essentials) and features for de-embedding the fixture, channel
emulation, and FFE/DFE equalizer support (Advanced).

You can use this application to do the following tasks:

Jitter and noise analysis from 0.5 Gb/s to greater than 60 Gb/s

Jitter and noise separation (see the Importance of Jitter and Noise Separation (see page 9))

Perform random and deterministic jitter and noise analysis, and TJ@BER, TN@BER and BER
estimation

Isolate jitter and noise due to crosstalk, and make random and deterministic estimations in the
presence of crosstalk

Show results as numeric and graphical displays

Display 2-D eye diagrams (Correlated Eye, Probability Density Function (PDF) Eye, and Bit Error
Rate (BER) Eye)

Supports FFE and DFE equalization

Allows user defined linear arbitrary filters

Supports Channel Emulation (from TDR/TDT and S-parameter based channel descriptions)

Analysis of jitter, noise, and BER in the presence of Spread Spectrum Clocking (SSC)

Save results to a data file

Save and recall instrument setups

See Also:

Review Requirements and Restrictions (see page 7)

Requirements and Restrictions

Operating system. Microsoft Windows 7 Ultimate (32 bit) operating system operating on the DSA8300
Digital Serial Analyzer oscilloscope.

ADVTRIG option. 80SJNB requires the Advanced Trigger option (ADVTRIG). Contact Tektronix about
purchasing this option.

82A04 Phase Reference module. For acquisition in the presence of Spread Spectrum Clocking (SSC), this
application requires that the sampling oscilloscope be equipped with a Tektronix 82A04 Phase Reference
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Getting Started Accessories

module. The 82A04 also lowers the jitter floor to 200 fs. Contact Tektronix about purchasing the module
for your sampling oscilloscope.

Keyboard and mouse. You must use a keyboard to enter names for some save and export operations. A
mouse is not required but simplifies screen selections.

Accessories

There are no standard accessories for this product. Refer to the product data sheet available on the
Tektronix Web site for information on optional accessories relevant to your application.

A second monitor connected to the TekScope is recommended for simultaneous viewing of the oscilloscope
screen and the 80SJNB application screen.

Refer to Requirements and Restrictions (see page 7) for additional items required to use the 80SJNB
application.

Connecting to a Device Under Test (DUT)

You can use any compatible probe or cable interface to connect your DUT and the instrument.

WARNING. To avoid electric shock, remove power from the DUT before attaching probes. Do not touch
exposed conductors except with the properly rated probe tips. Refer to the probe manual for proper use.

Refer to the General Safety Summary in your oscilloscope manual.

See Also:

Deskewing Probes and Channels (see page 8)

An Application Example (see page 65)

Deskewing Probes and Channels

To be sure of accurate results for two-channel measurements, it is important to first deskew the probes
or cables and oscilloscope channels before you take measurements.

NOTE. Deskewing is performed from the TekScope application, not from the 80SJNB application. Refer to
the DSA8300 Quick Start User Manual and the DSA8300 Online Help for information and procedures for
deskewing probes and channels.
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Getting Started The Importance of Jitter and Noise Separation

The Importance of Jitter and Noise Separation

Jitter is an important characteristic to analyze for serial data links, but the analysis should not stop at just
jitter. To properly evaluate a data link, it is necessary to analyze both jitter and noise.

Two components need to be added to the traditional jitter analysis:

The noise/vertical eye closure should be considered in a manner very similar to that of jitter/horizontal
eye closure.

Jitter measurements based on the threshold crossing of a finite-speed transition should include vertical
noise influence.

Depending on the magnitude of the vertical noise and the transient response of the transmitter and
transmission channel, the magnitude of this influence can vary widely. Ultimately the jitter and noise
analysis allows for accurate BER projections for the targeted communication link.

For information on the separation and analysis techniques used for jitter and noise analysis, download the
Tektronix white paper Tektronix CSA/TDS8200 Jitter Analysis Application: Jitter and Noise Analysis,
BER Estimation Descriptions with 80SJNB. Additional jitter analysis and timing analysis information is
available at www.tek.com/jitter.

Jitter and Noise Separation Methods

Bit error rates (BER) of a serial data stream are impacted by both jitter and noise. An accurate
decomposition of jitter and noise in the sources of impairments is critical to correctly estimate the signal
path behavior at larger BER. The jitter and noise maps are critical to help debugging the devices under test.

Since jitter and noise analysis follows a similar path, this discussion covers just the jitter decomposition.
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Getting Started Jitter and Noise Separation Methods

The basic separation of jitter in data-dependent and uncorrelated elements is accomplished by two targeted
acquisition steps:

Correlated Acquisition Step: the application filters a high resolution acquisition of the full pattern
to eliminate the uncorrelated elements. The analysis of the filtered pattern yields the data dependent
characteristics, such as Data Dependent Jitter (DDJ) and Duty Cycle Distortion (DCD).

Uncorrelated Acquisition Step: the uncorrelated elements of jitter are isolated by acquiring on well
defined single spots in the pattern, thus eliminating the dependency on the pattern itself. The data
acquired in the uncorrelated acquisition step is then further analyzed to isolate random unbounded
components from the bounded deterministic components. This extended analysis is critical to help
predict long term behavior of the DUT.

Historically only spectral separation was used for separation (available still as the Spectral (Legacy)
analysis method). This method improperly qualifies certain complex bounded uncorrelated components as
unbounded, which inflates the random jitter (RJ) measurement result.

Spectral separation with isolation of bounded uncorrelated jitter (Spectral + BUJ) works by also
analyzing the cumulative distribution function (CDF) of the uncorrelated non periodic jitter data. In
the spectral separation of Periodic Jitter from the Random Jitter, the distinct spectral lines are removed
from the frequency domain representation of the global uncorrelated jitter data to quantify the periodic
jitter components, PJ. In the legacy method, the spectral method evaluated the remaining spectral data
as Random Jitter (RJ).

The presence of complex bounded uncorrelated impairments (for example, originating from crosstalk)
requires significant additional steps to isolate the bounded, uncorrelated jitter (BUJ) from the periodic jitter
(PJ), nonperiodic jitter (NPJ), and random jitter (RJ) components.

The CDF analysis is performed in two steps: before and after the spectral separation that identifies the
periodic spectral components. The first analysis step yields the total bounded uncorrelated jitter, while the
second analysis step yields the nonperiodic elements, and finally the random jitter components.

A parallel analysis track develops the noise map, and a combination of the two analysis tracks characterizes
the behavior of the link in terms of bit error rate (BER).
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Operating Basics About Operating Basics

About Operating Basics

These topics cover the following tasks:

Navigating the user interface (see page 21)

User interface information (see page 19)

Using oscilloscope functions (see page 18)

Setting up the application (see page 24)

Viewing the measurement results as plots (see page 19)

Exporting Plot Files (see page 54)

Saving (see page 50) and recalling (see page 50) setup files

Saving (see page 51) and recalling (see page 51) data files

What do you want to do?

Start the 80SJNB Application (see page 11)

See Also:

File Name Extensions (see page 15)

File Menus (see page 16)

Starting the 80SJNB Application

There are several ways to start the 80SJNB application.

If the TekScope application is minimized, double-click the 80SJNB application icon on the Windows
desktop to start the 80SJNB application.

If the TekScope application is running and open, select Applications > 80SJNB.

In Windows, select Start > All Programs > Tektronix Applications > 80SJNB > 80SJNB.
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Operating Basics Returning to the Oscilloscope Application

TIP. With a second monitor connected to the TekScope, you can move the 80SJNB application display to
the second monitor, allowing you to view both screens at the same time.

See Also:

Returning to the 80SJNB Application (see page 13)

Returning to the Oscilloscope Application (see page 12)

Returning to the Oscilloscope Application

The 80SJNB application fills the entire screen and hides the TekScope application. To return to the

TekScope display, click the Back to Scope button in the toolbar.

You can also minimize the 80SJNB application or exit the 80SJNB application entirely.

See Also:

Minimizing and Maximizing the Application (see page 13)

Exiting the Application (see page 14)
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Operating Basics Returning to the 80SJNB Application

Returning to the 80SJNB Application

The TekScope application fills the entire screen. If the 80SJNB application is already running but the
TekScope application is displayed on top, bring the 80SJNB application to the front using one of the
following methods.

Click the App button on the TekScope toolbar.

Select Applications > Switch to 80SJNB.

TIP. If you have a keyboard attached, you can switch between running applications by pressing the Alt
+ Tab keys.

Minimizing and Maximizing the Application

To minimize the application to the Windows task bar, select the command button in the application
menu bar.

To maximize the application, select the minimized application from the Windows task bar. Alternately, if
you have a keyboard attached, switch between displayed applications by pressing Alt + Tab keys.
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Operating Basics Exiting the Application

Exiting the Application

To exit the application, select File > Exit or the command button in the application menu bar.

Installation Directory

The 80SJNB software is installed in the following directory:

C:\Program Files\TekApplications\80SJNB

Save and Recall Directory

The directory structure for saving and recalling setup and data files and exporting data is:

C:\Users\<user name>\Documents

The default user name is:

Tek_Local_Admin

See Also:

File Name Extensions (see page 15)
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Operating Basics File Name Extensions

File Name Extensions
Extension Description

.bmp File that uses a bitmap format

.csv File that uses a comma separated value format

.stp 80SJNB application setup file

.jpg File that uses a joint photographic experts group format

.mat File that uses native MATLAB binary format to store data acquired by 80SJNB

.png File that uses a portable network graphics format

.txt File that uses an ASCII format

.flt 80SJNB application filter file

.tap 80SJNB application equalization tap file

.wfm File that defines time domain waveforms or a frequency domain 1-port S-parameter (created
by IConnect) for channel emulation

80SJNB accepts both DSA8300 and IConnect .wfm files

.s1p

.s2p

.s4p

Files that define 1-port, 2-port, and 4-port frequency domain S-parameters

xxx
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Operating Basics File Menu

File Menu

The File menu lets you save and recall application setups, data files, and recently accessed files.

CAUTION. Do not edit a setup file or recall a file that was not generated by the application.

Menu item Description

Save Settings Saves the current application settings in a .stp file

Recall Settings Browse to select an application setup (.stp) file to recall; restores the
application and oscilloscope to the values saved in the setup file

Save Data Saves the current acquired data in a .mat file for later analysis

Saving is disabled if there is no acquired data to save or an acquisition is
now in process

Recall Data Recall a saved data file for analysis

All plots and results are based on the recalled data

Recalling is disabled if an acquisition is now in process

Export Results Exports jitter and noise analysis results to a csv format user specified file.

Signal attributes and analysis configuration parameters are added to the
report to qualify the measurement results.

Export Waveform Acquired exports the raw acquired pattern before processing of the data

Correlated exports the acquired waveform after filtering out the
uncorrelated components

Print Prints the displayed plots and the detailed statistics list

Print to File Creates a file of the displayed plots and a detailed statistics list

Exit Exits the application

xxx

See Also:

About the 80SJNB Tool Bar (see page 22)

Saving a Setup File (see page 50)

Recalling a Saved Setup File (see page 50)

Saving a Data File (see page 51)

Recalling a Saved Data File (see page 51)

About Exporting Plot Files (see page 54)
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Operating Basics View Menu

View Menu

The View menu lets you configure the display of plots and/or numerical data.

Menu item Description

1-up Displays a single plot on the screen

2-up Displays two plots on the screen

4-up Displays the maximum of four plots on the screen

Plots Hides all numeric data, expanding the displayed plot(s) to fill
the entire screen

Summary - SSC Displays the summary SSC numeric data below the plot
display(s)

Summary - Signal Path Displays the summary Signal Path numeric data below the
plot display(s)

Full Numeric Results Displays the complete list of numeric data with plots
displayed

xxx

See Also:

About the 80SJNB Tool Bar (see page 22)

Setup Menus

The Setup menus provide access to the various configuration menus.

Menu item Description

Acquisition Displays the Acquisition setup dialog screen to select and
configure the source for measurements and control key
oscilloscope setups

Signal Path Displays the Signal Path dialog screen to define the signal
path characteristics to simulate the actual conditions your
signal may encounter

Analysis Displays the Analysis dialog screen to change settings that
affect how measurements are made and displayed

Default Setup Returns the Acquisition, Signal Path, and Analysis settings
to their default values

See About Application Parameters (see page 71) to view the
default settings for each configuration menu

xxx

About the 80SJNB Tool Bar (see page 22)
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Operating Basics Oscilloscope Settings

Oscilloscope Settings

You should return the TekScope to its default state before launching the 80SJNB Acquisition dialog box.
All other acquisitions and math waveforms should be off, and all measurements, waveform databases,
masks, and histograms. You should not have to make changes to the oscilloscope settings from the
oscilloscope UI to successfully acquire data with the 80SJNB application. All relevant oscilloscope
settings are accessible using the Acquisition dialog box of the 80SJNB application.

NOTE. Changing oscilloscope settings while the 80SJNB application is acquiring data may cause errors,
unpredictable results, or failure.

To bring the TekScope application to the front of the display, click the Back to Scope button
or minimize the 80SJNB application. Alternately, you can use the Alt + Tab keys to switch between
applications if you have a keyboard attached.

See Also:

About Configuring the Application for Analysis (see page 24)

Returning to the Application (see page 12)

Minimizing and Maximizing the Application (see page 13)

About the Results

There are two ways to view analysis results: as numeric data and as graphical plots.

You can log the results data to .csv files for viewing in a spreadsheet, database, text editor or data analysis
program.

See Also:

Working with Results (see page 63)

Clearing Results (see page 19)

Exporting Plot Files (see page 54)

Exporting Results from the File Menu (see page 16)
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Operating Basics Clearing Results

Clearing Results

Click the Clear Data button to remove the existing plot displays and results. You may want to clear
the data before acquiring new data or between cycles when the sequence mode is set to Free run.

NOTE. The numeric results and plot files are erased each time a new acquisition cycle is started.

About Plotting

The application displays the results as plots for more comprehensive analysis. Before or after you take
measurements, you can select to display a single plot, two plots or four plots. You can select the type
of data you want to view in each plot window.

See Also:

Working with Plots (see page 52)

Plot Type Definitions (see page 52)

About Working with Results (see page 63)

About the User Interface

The application uses a Microsoft Windows-based user interface.

NOTE. The TekScope application is hidden when the 80SJNB application is running and not minimized.
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Operating Basics User Interface Items Definitions

See Also:

Starting the Application (see page 11)

Minimizing and Maximizing the Application (see page 13)

Exiting the Application (see page 14)

Definitions of the application user interface items (see page 20)

User Interface Items Definitions

Item Description

Area Visual frame that encloses a set of related options

Box Use to define an option; enter a value with the Keypad or
a Multipurpose knob

Browse Displays a window where you can look through a list of
directories and files

Check box Use to select or clear an option

Command button Initiates an immediate action, such as the Start command
button in the Control panel

Keypad On-screen keypad that you can use to enter numeric values

Menu All options in the application window (except the Control
panel) that display when you select a menu bar item

Menu bar Located along the top of the application display and contains
application menus
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Operating Basics About Navigation

Item Description

Status bar Line located at the bottom of the application display that
shows the acquisition status and the latest Warning or Error
message

Virtual keyboard On-screen keyboard that you can use to enter alphanumeric
strings, such as for file names

Scroll bar Vertical or horizontal bar at the side or bottom of a display
area that you use to move around in that area

Tool bar Located along the top of the application display and contains
application quick launch buttons

xxx

About Navigation

The application provides you with several ways to display the results:

The drop-down menus available in the menu bar allows for screen configuration (one, two, or four
plots, summary or full numeric results table)

The buttons in the tool bar allow for screen configuration

The drop-down menus available in the plot display windows allow you to choose from the available
plots, and Copy, Examine, and Export plots

The status bar at the bottom of the screen contains progress information and displays error conditions
detected

Double clicking on a displayed graph opens the plot in a MATLAB window. MATLAB provides
additional display capabilities such as panning, zooming, data cursors, and 3D rotation. The Examine
button from the drop-down menu of the plot also opens the MATLAB window.
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See Also:

Windows User Interface (see page 19)

About the 80SJNB Toolbar (see page 22)

About Configuring the Application for Analysis (see page 24)

About the 80SJNB Tool Bar

The toolbar provides quick access to the most common functions you need to configure the settings, start
the acquisition, and control the numerical and plot displays. Most tasks are also available using the
drop-down lists from the File menu bar.

Acquisition button . Use the Acquisition button to select and configure the source for
measurements and control key oscilloscope setups. Any change in the Acquisition settings clears all
the data. The Acquisition button is disabled during the acquisition and processing cycle.

Signal Path button . Use the Signal Path button to define the signal path characteristics to
simulate the actual conditions your signal may encounter. Changes made in the signal path settings
does not clear the data, only the results. The Signal Path button is disabled during the acquisition
and processing cycle.

Analysis Setup button . Use the Analysis Setup button to change settings that affect how
measurements are made and displayed. Changes made in the analysis settings does not clear the data,
only the results. The Analysis Setup button is disabled during the acquisition and processing cycle.

Free Run On/Off button . Use the Free Run button to select the sequence mode (free run on
or off).

When OFF, the button remains blue and the acquisition and processing cycle completes one pass
over the entire pattern. Off is the default mode.

When Free Run is ON, the button turns green indicating that the acquisition and processing
cycle repeats until stopped. The correlated components are averaged with previous data while the
uncorrelated components are accumulated for increased statistical content. At the completion of each
acquisition cycle, the plots and measurements are updated.

Free Run mode is recommended when:

There is a doubt that one acquisition cycle is enough. A change in the results indicate that additional
acquisition cycles was needed.
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The correlated waveform shows irregular disturbances. It is possible that uncorrelated information
can leak into the single-pass correlated filtering. Acquiring a larger statistical sample improves
analysis in the presence of crosstalk.

To halt a Free Run cleanly, deselect the button. This converts the Free Run mode back to Single
Sequence mode, so that the acquisition stops when the cycle is complete.

Run button . Use the Run button to start the acquisition and processing cycle. Once the run
button is pressed, do not change any instrument settings. When the Run button is pressed, all current
measurement data and plot displays are cleared. During the acquisition and processing cycle, the
Signal Path, Analysis, Acquisition, and Run buttons are disabled.

During the acquisition and processing cycle, the Run button is replaced with the Pause button .
Click Pause to interrupt the current acquisition and processing cycle. Click the button again to resume
the cycle. This is useful when the acquisition is set to Free Run, allowing you to halt the acquisition
and processing cycle so you can view and save the measurement data between cycles.

Stop button . Use the Stop button to end the acquisition and processing cycle. While in Single
Sequence mode, stopping the cycle produces no results and you must click the Start button to start a
new cycle.

Clear Data button . Use the Clear Data button to clear all results and plot displays. If Free Run
is set to ON (cumulating previous data with new), you can clear the existing results and plots during
the processing cycle, thus starting a new acquisition and processing cycle.

Plot Display . Use the window pane buttons to display between 1, 2, or 4 plots. You
can change the number of plot displays at any time.

Numeric Results Display . The results button changes the display to a complete list of statistics.
If the application is displayed on a larger screen, the numeric results display shows all the results at
once.

Back to Scope . Use this button to bring the TekScope display to the front of the screen.

See Also:

About Configuring the Application for Analysis (see page 24)

About Analysis Settings (see page 45)

80SJNB Printable Online Help 23



Operating Basics MATLAB User Interface

MATLAB User Interface

The 80SJNB application includes MATLAB® plots to provide further data analysis and visualization of
the plot displays.

MATLAB provides multiple capabilities to display and annotate the plot diagrams, including:

Pan and Zoom

2D and 3D visualization

Rotation

Data Cursors

Color enhancements

MATLAB is a product distributed by MathWorks. You can view the MATLAB documentation and
tutorials on their Web site: http://www.mathworks.com

About Configuring the Application for Analysis

The tool bar provides an Acquisition (see page 25) button to configure the application to acquire data,

a Signal Path (see page 35) button to set signal path conditions, and an Analysis (see page 45) button

to change settings that affect how measurements are made and displayed.

NOTE. The Acquisition settings must be set before starting an acquisition cycle. You can modify the Signal
Path and Analysis settings without the need to reacquire data.
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Use the Sequence button to have the acquisition and processing of data run continuously (free
run) or stop after one cycle is complete.

After setting up the application, you can select the Run button to start the acquisition and processing
cycle.

After the acquisition and processing cycle has completed, you can view the results as numerical (see
page 63) statistics or graphically (see page 19).

A typical scenario to setup the 80SJNB application and acquire data involves the following steps:

1. Set the Source, Data Rate, and Pattern Length.

2. Select a Stop on Condition.

3. Set the required Count.

4. From the tool bar, select Free Run mode.

5. Issue a Run command.

6. Wait until the 80SJNB application finishes running and then stops.

See Also:

About Acquiring Data (see page 25)

About Acquiring Data

Before making jitter and noise measurements, you need to select and configure the signal source.

Use the Acquisition button to display the Acquisition dialog box.

In the Acquisition dialog box, select the signal source and define the acquisition parameters. Some
parameters (such as the Clock Recovery, Phase Reference Sources, and the optical signal conditioning)
are copied from the oscilloscope state.

Click the AutoSync to Selected Source button to have the 80SJNB application automatically obtain and
enter the following information from the signal applied to the channel defined as the Signal Source:

Data Pattern Rate

Data Pattern Length

Recommended Data:Clock Ratio (when Spread Spectrum Clocking (SSC) signaling is used)

NOTE. Acquisition in the presence of SSC requires certain cabling propagation delays to be preserved.
Please contact Tektronix for an up-to-date diagram of cabling lengths.
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NOTE. Tektronix recommends running this functionality in the oscilloscope (the equivalent menu exists in
Setup > Mode/Trigger > Pattern Sync/FrameScan Setup). The important difference is that the oscilloscope
UI/PI allows manual entry of some of the parameters of the AutoSync, which dramatically improves the
success rate of AutoSync. For example, manually entering the Data Pattern Length, and then unchecking
the pattern length item from the AutoSync search, makes the data pattern length much more likely to
succeed. Refer to the DSA8300 TekScope application online help for details about the Pattern Sync settings.

See Also:

Selecting a Stop on Condition (see page 27)

Selecting Scope Setup Recall On Exit (see page 28)

Selecting Clock Recovery (see page 29)

Selecting Phase Reference (see page 30)

Selecting the Data Pattern (see page 31)

Selecting the Signal Conditioning (see page 31)

Selecting the Pattern Clock (see page 32)

Selecting the Source (see page 32)
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Analysis Settings (see page 45)

Selecting a Stop on Condition

The Stop on Condition selections allow you to control the amount of data to be acquired and processed
before stopping.

NOTE. The Free Run mode has to be selected for the Stop on Conditions to be active. Use the Sequence

button to select the continuous acquisition and processing mode.

There are four options to control the stop condition:

Never. This is the default condition. The acquisition and processing of data runs continuously until
explicitly stopped by user by clicking on the Stop button.

Acquisition Cycles. Acquisition Cycles instructs the 80SJNB application to continue acquiring and
processing data until the defined number of cycles have completed. Note that changing the number of
Acquisition Cycles coerces the numbers associated with the other two options. Each acquisition cycle
includes a number of uncorrelated samples, selected by design, and a number of samples correlated with
the data pattern, which depends on the pattern length and the number of samples per data bit – which is
also selected by design.

The following equation describes the relationship between these parameters:

Total Population Limit = Acquisition Cycles * (Uncorrelated_Samples_Per_Cycle + Samples_Per_Bit
* Pattern_Length)

Uncorrelated Samples. Uncorrelated Samples instructs the 80SJNB application to continue acquiring and
processing data until the data required for jitter and noise processing exceeds the specified number. The
default count is a number that represents 2 acquisition cycles.

Total Population Limit. Total Population Limit instructs the 80SJNB application to continue acquiring and
processing data until the total number of samples exceeds the specified number. The default count is a
number that represents 2 acquisition cycles, and reflects the selected Pattern Length.

The actual number of acquired and processed samples is displayed in Sample Count (see below), and
corresponds to the nearest integer number of acquisition and processing cycles.
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Selecting Scope Setup Recall On Exit

Acquiring data for jitter and noise analysis requires the 80SJNB application to fully control the
oscilloscope state. When this control is checked, exiting the 80SJNB application (File > Exit) restores the
oscilloscope to the state which was stored when 80SJNB application was launched.
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Selecting Clock Recovery

The Advanced Trigger option (ADVTRIG) that generates the pattern synchronous triggers requires a clock
source synchronous with the signal. When using a clock derived from a clock-recovery module installed
in the oscilloscope (such as optical modules and the 80A05), use the Pattern Clock fields to select the
source module, the configuration and its frequency.

All native clock recovery modules support two different configurations: one that connects the recovered
clock from the back of the module to the internal pattern synchronous trigger generator; and, for optimal
jitter performance, the module full rate clock output can be connected to the front panel Clock/Prescale
Input.

These settings are grayed out if no modules with clock recovery are detected at application startup.

The Rate setting is limited to the capabilities of the selected module. The numeric keypad is unavailable
for use unless the module can accept USER defined rates.
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Selecting Phase Reference

You can use a Phase Reference module (such as the 82A04) to reduce the trigger jitter of the signal source,
thus increasing the jitter measurement accuracy. If analyzing a signal using Spread Spectrum Clocking
(SSC), a Phase Reference module is required.

If using a Phase Reference module, set the channel source and the frequency of the applied clock.

These settings are grayed out if a Phase Reference module is not detected at application startup. If a Phase
Reference module is detected, you have the option to not use the module by selecting None as the Source.

TIP. Selecting a Phase Reference module dramatically improves the accuracy of DDJ (Data Dependent
Jitter) and the correlated waveforms. However, the throughput is lowered in this mode.

NOTE. When using a recalled data file, the Phase Reference Frequency field is updated to indicate the
frequency when the data was acquired. The Source field remains unchanged regardless if phase reference
was used when the recalled data file was created.
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Selecting the Data Pattern

Defining the Data Pattern requires that you define both the data rate of the signal source and the pattern
length in bits. You can choose the data rate from a predefined set of lengths or enter a value with the
numeric keypad.

NOTE. Selecting a data rate that does not match the communication standard that is set in the instrument’s
Horizontal Communication Standard setting dialog box causes the oscilloscope setting to change to User.

When selecting the pattern length, only the length is important. The precise bit sequence is unimportant
if it is repetitive.

To analyze a clock pattern, select a 2 bits pattern (or a multiple). The analysis is performed on both edges.

NOTE. When using a recalled data file, the Data Pattern fields are updated to indicate the state of the
settings when the data was acquired.

Selecting the Signal Conditioning

Use this control to select what type of filtering, if any, you want performed on the selected channel. The
available filters depend on the capabilities of the module.

If the Filter is set to None, you can use the Bandwidth box to select the bandwidth of the channel. The
available bandwidth selections depend on the capabilities of the module. Refer to the documentation for
the module about its filter or bandwidth settings.

80SJNB Printable Online Help 31



Operating Basics Selecting the Pattern Clock

Selecting the Pattern Clock

The Pattern Sync built-in capability provides user pattern synchronous triggers. The feature, enabled by
the Advanced Trigger Option (ADVTRIG), is driven by the Pattern Clock.

The available Pattern Clock sources depend on the instrument configuration. The default selection is
Clock/Prescale Input, and this selection is available for all configurations. Connect the clock source to
the CLOCK INPUT/PRESCALE TRIGGER front-panel connector.

When the oscilloscope is equipped with one or more clock recovery capable modules, the CR units are
also available as sources for the Pattern Clock.

Each native clock recovery source appears on the Pattern Clock source list twice to allow for two different
configurations:

Selecting Cx Clock Recovery sets the instrument to pick up the recovered clock from the back
of the module using and internal signal path.

Selecting Cx CR to Clock/Prescale Input sets the instrument clock recovery signal source to the
CLOCK INPUT/PRESCALE TRIGGER connector on the front panel. Connect the output of the clock
recovery module to the front panel CLOCK INPUT/PRESCALE TRIGGER input.

Depending on the data rate, choosing one configuration over the other could result in different intrinsic
jitter performance. See Selecting Clock Recovery (see page 29). In general, if there is SSC then a
particular cabling setup is necessary; only external Clock Recovery (such as with a CR125A) can be used.
If the PhaseRef 82A04 module is used in the absence of SSC, the 82A04 setup determines the jitter
performance. The intrinsic jitter of the pattern trigger circuit becomes invisible.

Selecting the Source

The application takes measurements on waveforms specified as sources (also called signal sources). The
source can be a channel (CH1 through CH8) or a math waveform (if one is defined). You can use any
defined math waveform, whether it is defined in the 80SJNB configuration as a differential setup or in
the TekScope application. (Defining a math waveform in the TekScope application must be done before
launching the 80SJNB application.)

When selecting a Data Source, all other channels and Math waveforms should be turned off. If any
channels or Math, other than the Data Source are activated after launching the 80SJNB application, an
error message will prompt you to deactivate all additional waveforms before starting the acquisition and
processing cycle. All other waveform databases, measurements, histograms and masks on the oscilloscope
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need to be turned off, as well. If any of these conditions exist when starting the acquisition and processing
cycle, you are prompted to turn these off before you can continue.

If your signal source uses Spread Spectrum Clocking (SSC), select the check box so that the application
can make accurate measurements accounting for clock rate modulation.

NOTE. If a saved data file is recalled, the signal source selection remains unchanged but all result
panels will indicate the recalled data file as the source. The “SSC is present” field is updated to match
the setting from the recalled data file.

See Also:

About Spread Spectrum Clocking (SSC) (see page 34)

Clicking the Diff button displays the dialog box to create a differential Math waveform by defining a
positive and negative waveform source (the negative waveform source is subtracted from the positive
waveform source). This generates a single mathematical waveform that the 80SJNB application can use
as the waveform measurement source.

TIP. You can use the DSA8300 TekScope Define Math dialog box (Edit > Define Math) to define more
complex math expressions. You must define the math expression in the DSA8300 before launching the
80SJNB application. Refer to the online help for your oscilloscope.
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About Spread Spectrum Clocking (SSC)

Spread Spectrum Clocking (SSC) is the technique of modulating the clock frequency to minimize EMI
effects. SSC affects the analysis process and the results of jitter, noise and BER measurements. If SSC
is not corrected for its effects, the results show as a large amount of periodic jitter components that are
reflected in the total jitter and noise, and ultimately in the BER estimates.

When SSC is present, 80SJNB measures the attributes of SSC and corrects the results.

Configuration Requirements

If using clock recovery, the clock recovery unit must be able to handle SSC. Use one of the Tektronix
BERTScope clock recovery instruments if SSC is present in the signal.

The TekScope must have an 82A04 Phase Reference Module installed. The module minimizes the effect
of the SSC on the data by sampling synchronously the data and clock. Also, by acquiring the clock in the
82A04 module, 80SJNB characterizes the SSC present in the clock and uses that information to correct the
jitter, noise, and BER measurements performed on the data.

TIP. The “SSC is present” check box is disabled if the Phase Reference module is not installed in the
instrument.

Use the following settings to optimize the SSC phase correction for the signal you are measuring:

Data rate range
Clock recovery
frequency 2

Clock recovery
output rate 1, 2

Data:Clock ratio
(JNB)

Phase reference
frequency (JNB)

500 Mbps – 1 Gbps Data Rate * 4 Standard 1:4 Data Rate * 4

1 Gbps – 2 Gbps Data Rate * 2 Standard 1:2 Data Rate * 2

2 Gbps – 4 Gbps Data Rate Standard 1:1 Data Rate

4 Gbps – 8 Gbps Data Rate Subrate (1/2) 2:1 Data Rate/2

8 Gbps – 12.5 Gbps Data Rate Subrate (1/4) 4:1 Data Rate/4

xxx

1 The Clock Recovery unit clock output is either Standard or Subrate Clock.
2 Clock recovery is typically provided from a CR125A, CR175A, or CR286A BERTScope Clock Recovery Instrument.

When you instruct 80SJNB that the data has SSC (by checking the “SSC is present” check box), the
following constraints are enforced based on the current Data Rate:

Phase Reference source is selected.

Phase Reference frequency is set to the recommended value in the table Configuration Settings for SSC.

A recommended Data:Clock Ratio is displayed to suggest the recommended subrate clock.

NOTE. Changes to the Data Rate are reflected in the Phase Reference Frequency and Data:Clock Ratio.
You must make the appropriate changes to the Clock Recovery unit parameters.
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The status (on or off) of the SSC setting is displayed in both the Summary – SSC view and the Full
Numeric Results page. The results of the SSC analysis are presented in two forms, numeric results and a
plot. When viewing the full numeric results table, the SSC Modulation section has two fields: Magnitude
and Frequency. Magnitude represents the depth of the SSC clock modulation in parts-per-million (ppm)
and Frequency reflects the SSC modulation frequency.

To view the plot of the SSC modulation profile, select the Plot>SSC>SSC Profile.

TIP. The configuration settings are also available through the GPIB programming interface of the
oscilloscope. Refer to the information provided with the oscilloscope.

About Serial Data Link Analysis (SDLA) Signal Path Settings

The Signal Path Settings are available for use with the 80SJNB Advanced version. If you are using the
80SJNB Essentials version, you're allowed to use the dialog boxes but are not allowed to place any
of the functions into the signal path.

The Signal Path settings allow you to emulate the environment your signal encounters, all the way from
the transmitter to the receiver. With the Signal Path dialog box, your signal path is represented by a line
from the transmitter (Tx) to the Receiver (Rx). Along this line, you have the ability to emulate an arbitrary
filter and/or a channel. You can then define an equalizer to compensate for the effects the filter and channel
introduce. Also, fixture de-embed is supported.

Selecting a signal path arrow (Filter, Channel, or Equalizer) inserts or removes the function from the signal
path. When inserting a function into the signal path, its dialog box automatically displays.

Selecting a signal path button (Filter, Channel, or Equalizer) displays the dialog box for that function
without inserting or removing the function from the signal path.
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By simulating the signal environment, you can effectively emulate probing the signal at the receiver rather
than the output of the transmitter. With the use of the Equalizer, you can then design compensations to
improve the signal quality at the receiver.

TIP. You can move a function in and out of the signal path without affecting any settings.

To learn more about each of the signal path settings, select the following:

Filter (see page 36)

Channel (see page 37)

Equalizer (see page 39)

Setting Filter Conditions

The Signal Path Filter allows you to specify an arbitrary linear FIR filter to be applied to the acquired
data pattern. For instance, the transmitter may artificially enhance the signal at certain frequencies to
overcome known problems in the channel. You can use a filter to emulate this action or compensate for
transmitter signal pre-emphasis.

To use the filter, move the Filter function into the signal path and use the Filter file box or browse button to
specify the filter file. The default location for the filter files is in the Windows/Documents folder. A few
filter files are provided as examples, but you are responsible for providing the filter files.

To use the Filter block for de-embedding, you will need an additional software tool to create a
de-embedding filter from the S-parameters of the fixture. Please visit the www.tektronix.com/sdla Web
site, or contact Tektronix Support for details.

See Uncorrelated Scaling (see page 44) for information about this setting.

The following is an example of the filter file format:

36 80SJNB Printable Online Help

http://www.tektronix.com/sdla


Operating Basics Setting Channel Conditions

# This is a sample filter file. The '@' means that it is valid for all frequencies.
# Up to 20,000 coefficients may be specified.
@ 5.7e-005, 2.4e-005, 5.4e-005, 2.1e-005, 5.1e-005

Setting Channel Conditions

The Signal Path Channel allows you to emulate the channel (interconnect or lane) carrying the signal.
There are two ways to define the channel, with Time Domain (see page 39) waveforms and Frequency
Domain (see page 37) S-parameters.

See Uncorrelated Scaling (see page 44) for information about this setting.

Frequency Domain

With Frequency Domain selected, the channel is defined with an S-parameters file. Use the file selection
box or Browse button to select the file. The default location for the files are in the Windows/Documents
folder. You are responsible for providing the S-parameters file.

The S-parameters file can contain data for 1-port, 2-port, or 4-port devices. Once a file is selected,
the application reads its contents and generates the appropriate dialog for you to select the particular
S-parameter in the file to use.

1-Port. Files with 1 port of data contain only 1 S-parameter so they do not require any further input. These
files may be IConnect 1-port files or Touchstone 1-port files.

2-Port. Files with data for 2 ports contain 4 S-parameters as a 2x2 matrix. These are Touchstone 2-port
files. When the application recognizes such an S-parameter file, a dialog is created for you to select the
S-parameter representing channel transmission. The typical selection is S21, and is the default selection,
but this may need to be changed if the file contains a 2x2 subset of the 4x4 matrix of S parameters defining
a 4-port system.
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4-Port. Files with data for 4 ports may contain single-ended or mixed-mode data. These are Touchstone
4-port files.

If the data is single ended, you must map the port numbers as used in the file to physical locations in your
link. A default mapping is assumed. The application will use this mapping to compute the Sdd21 parameter
(for transmission of a differential signal) from the appropriate four S-parameters measured using single
ended data.

If the data is mixed mode, you must select the data layout in the file. The most common layout is DC12
and is the default selection. The application always uses the Sdd21 parameter for computing the transmitted
waveform no matter which mapping is selected.

NOTE. 80SJNB Advanced uses the 'insertion loss' information only.
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Time Domain

With Time Domain selected, the Reference waveform and Transmitted waveform generate the channel
behavior. Use the file boxes or browse buttons to select the files you want to use. The default location
for the files is in the Windows/Documents folder. You are responsible for providing the time domain
waveform files.

NOTE. We recommend that the waveform file be a measurement of the channel from a Tektronix TDR/TDT
system. Required raw oscilloscope waveforms are:

a. A reference throughput (no DUT is inserted, just a throughput connection between the TDR step
source and the acquisition channel on the TDT end).

b. A DUT throughput measurement (the TDR step source and the TDT acquisition channel are connected
through the DUT).

About the Equalizer

The equalizer compensates for transmission channel impairments in the form of frequency-dependent
amplitude and phase distortions resulting in intersymbol interference (ISI) in the communication data
stream.

80SJNB provides tools to define an equalizer by a set of Taps or weights. The linear feed-forward
equalizer (FFE) is defined by a user specified number of taps, taps per symbol (or unit interval), and the
weight of each tap. The equalizer becomes a decision-feedback equalizer (DFE) when the number of DFE
taps is set to a number larger than 0.

NOTE. Tap values and weights are used interchangeably.
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To learn about setting up the Equalizer, see:

Equalizer Taps (see page 40)

Uncorrelated Scaling (see page 44)

Equalizer Taps

The behavior of the equalizer is controlled by the number of taps and the tap values. Using the equalizer
requires that you specify the number of FFE and DFE taps, and the FFE spacing of the taps. You can also
incorporate an equalizer filter delay by specifying a reference tap to compensate for precursor channel
effects.

You can manually set the FFE and DFE tap values, or you can use the Autoset Taps button to let the
application calculate the tap values.
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Go to FFE Taps description (see page 41)

Go to DFE Taps description (see page 42)

FFE Taps

The FFE Taps are weights applied to a set of samples taken from the data stream to compensate for
channel impairments manifested in the form of ISI. The number of FFE Taps represent the length of
history in data samples that contribute to the computation of a current bit. Data stream samples could
be distanced at unit intervals, in which case the number of FFE taps represents the number of preceding
bits that contribute to the correction of the current bit. Alternatively, the data stream could be sampled
at a higher rate per bit, yielding a fractionally-spaced FFE tap set.

The number of FFE taps defaults to 1, with the capability to specify up to 100 taps. The default FFE tap
spacing is at unit intervals. You can configure up to 10 taps per symbol.

The FFE Tap values could be specified by you using the FFE Taps dialog, or computed by the application
with the Autoset Taps button.

Go to Autoset Taps description (see page 43)

Go to Saving and Loading Taps (see page 44)

Pressing the FFE Taps button displays a dialog showing the current FFE tap values. You can specify each
FFE tap coefficient individually. Pressing the Defaults button sets the first FFE tap to 1 and the rest to 0.
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You can use the Save Taps button to save a set of coefficients to a file. Use the Load Taps button to load
saved Tap files.

DFE Taps

DFE taps are weights applied to the previous digital decisions made by the slicer (comparator + latch). The
number of DFE Taps specifies the number of bits contributing to the current input to the slicer. The default
number of DFE Taps is 0, in which case the equalizer is a linear FFE one. The maximum number of DFE
Taps is 40. Weights are scalars specified by you or computed by the Autoset Taps function.

See Autoset Taps (see page 43) for a description about using the autoset taps function.

Pressing the DFE Taps button displays a dialog showing the current DFE tap values. You can specify each
DFE tap coefficient individually. Pressing the Defaults button sets all DFE tap values to 0.

You can use the Save Taps button to save a set of coefficients to a file. Use the Load Taps button to
recall saved Tap files.

TIP. When using the Equalizer, you are required to always have at least 1 FFE tap. DFE taps are optional.

Filter
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FFE Reference Tap. The FFE Reference Tap is a filter delay in unit intervals that should be set to
compensate for the delay between the transmitter output and the equalizer input. The value of the
Reference Tap is constrained by the number of FFE Taps and the number of taps per symbol.

Rise Time Selector. The Rise Time Selector specifies the Gaussian filter used to emulate the DFE feedback
path band-limited behavior. The rise time defaults to Track Data Rate, in which the configuration is
set to 1/5 of the unit interval equivalent with the data rate. Track tap interval designs a Gaussian filter
with a rise equal to 1/5 of the spacing between taps. Selecting User allows you to specify the rise time
from 1 ps to 4 ns.

Uncorrelated Scaling. See Uncorrelated Scaling (see page 44) for a description of this control.

Autoset Taps

The tap autoset function computes a set of tap values that optimize the eye opening for the data pattern
applied to the input of the equalizer. If the DFE tap number is 0, the algorithm yields an optimal set of FFE
taps, while if the equalizer is specified as a DFE by a positive DFE tap number, the Autoset Taps algorithm
jointly optimizes the forward and feedback loop tap coefficients. The optimization algorithm is the
least-mean-square error (LMS) and the optimization targets the signal to noise ratio at the sampling phase.

The Autoset Taps will account for the FFE Taps/Symbol and Reference Tap specifications.

The autoset algorithm assumes the availability of a training sequence, thus it supports only a known set of
patterns: PRBS3 to PRBS15 with the following generator polynomial equations:
PRBS3: x3+x2+1
PRBS4: x4+x3+1
PRBS5: x5+x4+x2+x1+1
PRBS6: x6+x5+x3+x2+1
PRBS7: x7+x6+1
PRBS8: x8+x7+x3+x2+1
PRBS9: x9+x5+1
PRBS10: x10+x7+1
PRBS11: x11+x9+1
PRBS12: x12+x9+x8+x5+1
PRBS13: x13+x12+x10+x9+1
PRBS14: x14+x13+x10+x9+1
PRBS15: x15+x14+1

The tap autoset algorithms computes a set of FFE and DFE taps using a least-mean-square optimization
algorithm. The optimization algorithm is the least-mean-square error (LMS) and the optimization targets
the signal to noise ratio at the sampling phase.

NOTE. You can autoset tap values even if the Equalizer is not inserted in the signal path.

80SJNB Printable Online Help 43



Operating Basics Saving and Loading Taps

Saving and Loading Taps

Use these controls to save or load a set of taps from a file. The browse directory defaults to Windows/My
Documents and the file extension is .tap.

The file format is the following:

<Tektronix>
<TapFile>
<FFE>

<TapsPerSymbol>value<\TapsPerSymbol>
<ReferenceTap>value<\ReferenceTap>
<Tap1>value<\Tap1>
<Tap2>value<\Tap2>
...
<Tapn>value<\Tapn>

</FFE>
<DFE>

<Tap1>value<\Tap1>
<Tap2>value<\Tap2>
...
<Tapn>value<\Tapn>

</DFE>
</TapFile>

</Tektronix>

Uncorrelated Scaling

The signal path settings (Filter, Channel, Equalizer) each have an uncorrelated scaling setting. The
Uncorrelated Scaling value multiplies the uncorrelated random noise RMS and uncorrelated periodic noise
values. Uncorrelated noise scaling affects the uncorrelated jitter as projected through the average slew rate.
The 80SJNB Signal Path does not process uncorrelated noise in any other way.

If you insert a default equalizer (an FFE Tap 1 value equal to 1, and zero DFE taps) in the Signal Path
and set the Uncorrelated Scaling factor to its minimal value (0.01), the configuration will isolate the
effects of noise on jitter measurements. This configuration produces results that correlate with “jitter
only” type analysis tools.

NOTE. The overall Signal Path uncorrelated scaling factor is the product of all signal path uncorrelated
scalar values of the active functions.
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About Analysis Settings

The Analysis settings affect how measurements are made and displayed. The settings are saved with the
80SJNB application whenever it is closed so that restarting the application results in using the same
settings.

TIP. Changes to Analysis settings are reflected in the current plots and results.

Setting the Analysis Method

The Method selection sets which analysis methodology to use for the Jitter and Noise breakdown:

The Spectral + BUJ (Bounded Uncorrelated Jitter) is using a combination of spectral isolation of
the periodic components and the analysis of the cumulative distribution function (CDF) of the
uncorrelated jitter and noise data, before and after spectral separation. The presence of crosstalk
dictates the selection of this method.

The Spectral (Legacy) mode relies on spectral separation of the periodic and random components.

The default setting is Spectral + BUJ. When switching the analysis method between the two options, the
acquisition data is preserved, and new results are recomputed, displayed, and plots made available.

Setting the Decision Threshold

The Decision Threshold specifies the level at which to determine the crossing points on the edges of the
measured waveform.

When set to Absolute, the decision threshold uses the absolute value provided in volts (electrical) or
watts (optical).
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When set to Normalized, the decision threshold is calculated based on waveform data according to the
percent value of the signal amplitude.

Setting the Time Unit

The Time Unit sets the units (Seconds or Unit Intervals) used when displaying the measurement results.

Setting the Sampling Phase

The Sampling Phase determines the location of the sampling point for the Vertical Eye Opening and all
correlated noise measurements within the bit interval.

When set to Seconds, the sampling point uses the absolute value entered. Zero seconds is at the center of
the bit interval.

When set to Unit Intervals, the sampling point is calculated based on the bit interval. Zero UI is the
center of the unit interval.

Setting the Measurement Bit Error Rate

The Measurement BER determines the rate for which the measurements (such as TJ@BER) are predicted.

Taking Measurements

You should return the oscilloscope to its default state before launching the 80SJNB (acquisitions and math
waveforms should be off, and all measurements, waveform databases, masks, and histograms). You
should not have to make changes to the oscilloscope settings from the oscilloscope UI to successfully
acquire data with the 80SJNB application. The most relevant oscilloscope settings are accessible using the
Configuration dialog box of the 80SJNB application.

Displaying Measurements

You can use the tool bar to select how the results are displayed: numeric results, plots (up to four), or a
combination.

What do you want to do?

Display the definitions of Jitter measurements (see page 47)

Display the definitions of Noise measurements (see page 48)

Measurement Algorithms (see page 95)

Go to Working with Numeric Results (see page 63)

Go to Working with Plots (see page 52)
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Jitter Measurement Definitions
Jitter measurements Description

Random Jitter

RJ (RMS) Measured Random Jitter

RJ(h) (RMS) Horizontal component of random jitter

RJ(v) (RMS) Vertical component of random jitter induced by noise converted to jitter
through an average slew rate

Deterministic Jitter

DJ Measured Deterministic Jitter

DDJ Data Dependent Jitter

DCD Duty Cycle Distortion

DDPWS Data Dependent Pulse Width Shrinkage

BUJ(d-d) Measured Bounded Uncorrelated Jitter, Dual Dirac model

PJ Measured Periodic Jitter (peak-to-peak)

PJ(h) Horizontal component of periodic jitter (peak-to-peak)

PJ(v) Vertical component of periodic jitter (peak-to-peak) induced by noise
converted to jitter through an average slew rate

NPJ(d-d) Measured NonPeriodic Jitter, Dual Dirac model

Total Jitter @ BER

TJ (1E-12) Total Jitter at user-specified BER

Eye Opening (1E-12) Horizontal Eye Opening at user specified BER

xxx

NOTE. J2 Jitter: For a BER specified as 2.5E-3, the Total Jitter becomes J2 Jitter. J2 Jitter measures all
but 1% of the statistical total jitter distribution.

J9 Jitter: For a BER specified as 2.5E-10, the Total Jitter becomes J9 Jitter. J9 Jitter represents an
estimation of all but 10E-9 of the statistical total jitter distribution.

Dual Dirac Measurement Definitions
Dual Dirac Description

RJ(d-d) Random Jitter computed in the Dual Dirac model

DJ(d-d) Deterministic Jitter computed in the Dual Dirac model

xxx
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Noise Measurement Definitions
Noise measurements Description

Random Noise

RN (RMS) 1 Measured Random Noise

RN(v) (RMS) Vertical component of random noise

RN(h) (RMS) Horizontal component of random noise induced by jitter
converted to noise through an average slew rate

Deterministic Noise

DN Measured Deterministic Noise

DDN Data Dependent Noise

DDN(level 1) Data Dependent Noise on logical level 1

DDN(level 0) Data Dependent Noise on logical level 0

BUN(d-d) Measured Bounded Uncorrelated Noise, Dual Dirac model

PN 1 Measured Periodic Noise

PN(v) Vertical component of periodic noise (peak-to-peak)

PN(h) Horizontal component of periodic noise (peak-to-peak)
induced by jitter converted to noise through an average slew
rate

NPN(d-d) Measured NonPeriodic Noise, Dual Dirac model

Total Noise @ BER

TN (1E-12) Total Noise at user-specified BER

Eye Opening (1E-12) Eye Opening at user-specified BER

Eye Amplitude The amplitude of the eye computed as the mean-to-mean of
logical 1 and logical 0 bit levels sampled at the user defined
Sampling Phase.

xxx

1 Uncorrelated random noise (RN) and periodic noise (PN) measurements are performed on both logical levels 1 and 0 to account for significant
differences, which may be the case when the measurements are performed on optical signals.

SSC Modulation Measurement Definitions
SSC modulation measurements Description

Magnitude Spread spectrum clock modulation magnitude of the clock in
parts-per-million (ppm) units.

Frequency Spread spectrum clock modulation frequency.

xxx
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Sample Count

Both results tables, Summary and Full Results are displaying the Sample Count of the data used for the
derivation of the measurements.

The Sample Count field represents the amount of statistical data acquired and analyzed, and contains the
full pattern acquisition, the jitter and noise characterizing data.

When in Free Run, the count is continuously incremented with the newly acquired and processed data.

Steps to Acquire Data

To acquire data from acquisition channels and take measurements, follow these steps:

1. Select to display the Acquisition dialog box and configure the application according to your
setup and signal type.

2. Select to toggle the acquisition mode between free run (continuous) and single acquisitions and
processing cycles. When in Free Run mode, the following acquisition and processing continues
until you stop it:

acquisition and averaging of data-correlated patterns

acquisition, accumulation and statistical analysis of uncorrelated data

3. Select to start the acquisition and processing cycle.

To stop the acquisition, do one of the following:

If you wish to stop the acquisition and processing cycle before it completes, select . This may
be useful if you have started a sequence on a long waveform and then realize you would like to
change the configuration.

If you wish to interrupt the acquisition and processing cycle, select . Select a second time to
resume the acquisition.

If you wish to halt a Free Run mode cleanly, toggle the Sequence button. This will convert the
Free Run mode (indicated by the green button) to Single cycle mode (indicated by the blue button) so
that the acquisition stops when the cycle is complete. Single cycle is the default mode.

TIP. Use the Clear Data button to delete all measurement results and plots.
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Saving and Recalling Setup Files

You can use the File menus to save and recall different oscilloscope and application setups. Setup files
store the oscilloscope and application settings.

CAUTION. Do not edit a setup file or recall a file that was not generated by the application.

See Also:

Saving a Setup File (see page 50)

Recalling a Saved Setup File (see page 50)

Saving a Setup File

To save the 80SJNB application and oscilloscope settings to a setup file, follow these steps:

1. Select File > Save Settings to open the Save dialog box.

2. In the file browser, select the directory in which to save the setup file.

3. Use the keyboard to enter a new file name. The application appends a .stp extension to the file name.

4. Save the setup file. If the selected file name already exists, a confirmation dialog appears that allows
you to cancel the operation.

NOTE. The application saves the oscilloscope setup.

Recalling a Saved Setup File

To recall the application and oscilloscope settings from saved setup files, follow these steps:

1. Select File > Recall Settings to open the Recall dialog box.

2. In the Recall dialog box, select the directory from which to recall the setup file.

3. Select a setup file name, and then select Open.

CAUTION. Do not manually edit setup files. If you try to recall a setup file that was manually edited, the
recall operation fails.
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Saving and Recalling Data Files

You can use the File menus to save acquired data and then recall it later for analysis.

CAUTION. Do not edit a data file or recall a data file that was not generated by the application.

See Also:

Saving a Data File (see page 51)

Recalling a Saved Data File (see page 51)

Saving a Data File

To save the data acquired by the 80SJNB application, follow these steps:

1. Select File > Save Data to open the Save dialog box.

2. In the file browser, select the directory in which to save the data file.

3. Use the keyboard to enter a new file name. The application appends a .mat extension to the file name.

4. Save the data file. If the selected file name already exists, a confirmation dialog appears that allows
you to cancel the operation.

Recalling a Saved Data File

To recall the acquisition data from saved data files, follow these steps:

1. Select File > Recall Data to open the Recall dialog box.

2. In the Recall dialog box, select the directory from which to recall the data file.

3. Select a data file name, and then select Open.

CAUTION. Do not manually edit setup files. If you try to recall a setup file that was manuallyedited, the
recall operation fails.
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About Working with Plots

You can display plots in a variety of layouts using the tool bar. One, two, or four plots can be displayed

using the plot display buttons in the toolbar. When displaying plots, the results data table
changes to a summary table of data. To remove the plots entirely from the display, select the Show

Numeric Results button on the tool bar.

If the plots have been removed from the display, redisplay the plots by either selecting one of the plot
display buttons or click the tab of the data table.

See Also:

Plot Type Definitions (see page 52)

Functions in Plot Windows (see page 54)

About Exporting Plot Files (see page 54)

Selecting and Viewing Plots (see page 53)

Plot Type Definitions

Plot types are divided into the following categories:

Jitter: See Jitter Plots (see page 58) for a list of the types of jitter plots and their descriptions.

Noise: See Noise Plots (see page 61) for a list of plot types and descriptions.

Eyes: See Eye Plots (see page 59) for a list of plot types and descriptions.

Patterns: See Pattern Plots (see page 62) for a list of plot types and descriptions.

SSC: See SSC Plot (see page 62) for a description.
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Selecting and Viewing Plots

To select and view a plot, follow these steps:

1. Select one of the plot views , (single plot, two plots, or four plots).

2. For each plot window, select a type of plot to display. Each plot display is based on the current analysis
results. Plots are updated as new results are acquired.

To select a plot type for display in the plot window, click on the tab of the plot window. (Alternatively,
you can right-click anywhere on the existing plot display.) From the drop-down menu, use the Plot menu
to select a plot from the plot categories (Jitter, Noise, Eyes, Patterns, SSC).

See Also:

About Exporting Plot Files (see page 54)
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Examining Plots

You can examine plots in greater detail by either double-clicking in the plot window or selecting Examine
from the drop-down list in the plot window. Either of these actions launches a MATLAB plot window
which provides advanced tools to examine graphical displays of data.

See Also:

MATLAB User Interface (see page 24)

About Exporting Plot Files

There are two ways to export plot information from the 80SJNB application for use in other applications:

You can export the numerical data that is represented in the plot figure. This may be useful for
performing additional data processing.

You can create an image file that captures the current plot view. This is a useful way to document
your results.

The application offers the following choices from the drop-down list (right-mouse click over the selected
plot).

Plot lets you select a different plot to display in the window. The window displays the new plot
based on the acquired data.

Examine opens a MATLAB plot window which provides additional tools to more closely examine plot
characteristics.
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Copy Image saves the contents of the plot window as an image file.

Export saves the numerical values from the plot window in text or MATLAB format.

NOTE. Export plot functions are disabled whenever the application is actively sequencing.

See Also:

Exporting Raw Plot Data (see page 56)

Exporting Plot Images (see page 55)

File Name Extensions (see page 15)

Copying Plot Images

You can copy the plot image displayed in any one of the plot windows. The copy is placed in the Windows
clipboard so you can paste the image into other Windows programs. This is convenient for creating
reports and engineering records to share with others.

To create an image file of a plot, follow these steps:

1. Tap the area of the plot window of the plot that you want to copy. (If using a mouse attached to
the instrument, right-click anywhere within the plot window of the plot you intend to copy.)

2. Select Copy Image from the drop-down list. This copies the image to the Windows clipboard.

3. Open your destination program (such as WordPad or Paint) and paste the image into the application.

See Also:

Exporting Raw Plot Data (see page 56)
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Exporting Raw Plot Data

The 80SJNB provides two methods to export the raw plot data:

Export Waveform. Accessed from the File menu, exports the underlying acquired waveform and
correlated pattern data used for processing.

Export. Accessed from the plot window, exports the data used to create the plot image. This method
allows access to any node along the signal path.

NOTE. The 80SJNB application can produce files that are too large for some spreadsheet programs to load
completely. However, you can use a text editor to view the entire file.

Export Waveform

To export the waveform data used for processing, follow these steps:

1. Select File > Export Waveform > Acquired or File > Export Waveform > Correlated:

The Acquired waveform contains the raw acquired pattern before any processing is done on it. (The
only processing on the raw data is interpolation for NULL points.)

The Correlated waveform is the result of filtering the Acquired Waveform to eliminate uncorrelated
components (such as random and periodic jitter and noise).

3. Use the Export Waveform dialog box to specify the file name and path. The file name default
is “Correlated” or “Acquired” (depending on the selection), with the default file location at
Windows/Documents. Enter a new file name and/or directory location as needed.
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4. Use the drop-down Save as type list to select the file type. The choices are:

Comma Separated Values (.csv): ASCII text that can be loaded into a spreadsheet. This is the
default selection.

MATLAB (.mat): Binary data in the native MATLAB 7.0 format.

5. Click Save.

TIP. Binary files typically use about 40% more disk space than .csv files.

Export Graph (Plot)

To export the numeric data used to create a specific plot, follow these steps:

1. Touch the area of the plot window of the plot you want to export. (If using a mouse attached to
the instrument, right-click anywhere within the plot window that you want to export.)

2. Select Export from the drop-down menu.

3. Use the Export Graph dialog box to specify the file name and path. The file name default is “Graph,”
with the default file location at Windows/Documents. Enter a new file name and/or storage location
as needed.

4. Select the file type from the Save as type. The choices are:

Comma Separated Values (.csv): ASCII text that can be loaded into a spreadsheet. This is the
default format.

MATLAB (.mat): Binary data in the native MATLAB 7.0 format.

See Also:

Copying Plot Images (see page 55)
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Jitter Plots
Jitter plots Description

DDJ vs Bit 1 Data Dependent Jitter versus Bit displays the deviation of edge crossings at the
user-specified Decision Threshold for each bit of the entire pattern. The pattern itself
is shown in the background for cross reference. If the pattern is very long, the bits
are visible only when opening the graph with Examine.

DDPWS vs Bit 1 Data Dependent Pulse Width Shrinkage versus Bit displays the pulse width shrinkage
for each isolated one and zero in the pattern.

DDJ PDF Data Dependent Jitter Probability Density Function is the histogram of the data pattern
correlated jitter, including Duty Cycle Distortion. The PDF is composed of the crossing
deviations at the user specified Decision Threshold of all edges of the data pattern.

DDJ Spectrum 1 The Data Dependent Jitter Spectrum is the result of the time domain to frequency
domain transformation of the series of crossing deviations of data pattern edges at
the user specified Decision Threshold.

RJ PDF Random Jitter Probability Density Function shows the Gaussian distribution of the
random, unbounded, uncorrelated jitter component. It is computed from data acquired
on a single edge of the bit stream.

PJ PDF Periodic Jitter Probability Density Function represents the histogram of the
uncorrelated, bounded, periodic jitter component. It is computed by spectral
separation of the jitter data acquired on a single edge of the bit stream.

RJ*PJ Spectrum 1 Random and Periodic Jitter Spectrum represents the spectral distribution of the
uncorrelated jitter acquired on a single edge. The spurs represent the periodic jitter
spectral lines, and the rest of the evenly distributed spectral lines compose the
random jitter spectrum.

RJ*PJ PDF Random Jitter and Periodic Jitter Probability Density Function is the histogram of the
uncorrelated jitter data acquired on a single edge of the pattern.

DJ PDF Deterministic Jitter Probability Density Function shows the distribution of the bounded
jitter component. The histogram is computed by convolving the DDJ PDF with the
PJ PDF.

TJ PDF Total Jitter Probability Density Function represents the computed histogram derived
from all jitter components, correlated and uncorrelated, bounded and unbounded.
The convolution of DJ PDF and RJ PDF yields the Total Jitter histogram.

58 80SJNB Printable Online Help



Operating Basics Eye Plots

Jitter plots Description

BER Bathtub The BER Bathtub curve is computed as a horizontal slice of the 3-dimensional BER
Eye at the Decision Threshold. It represents the extrapolated total jitter and horizontal
eye opening limits at projected bit error rates.

Q Bathtub The Q-scaled curve is a linearized scale version of the BER Bathtub curve. It
represents the extrapolated total jitter and horizontal eye opening limits at projected
bit error rates.

xxx

1 The zoom feature defaults to horizontal zoom only.

Eye Plots
Eye plots Description

Correlated Eye 1 The Correlated Eye is a color graded eye pattern built by folding the correlated
pattern at clock rates. The correlated pattern is computed from the acquired
full length data pattern by filtering out the uncorrelated components.

PDF Eye plots can be computed at various stages of the signal path emulator
when using the 80SJNB Advanced version. When using the Essentials version
of the 80SJNB, all PDF Eye plots are identical.

If a signal path component is not inserted into the signal path, the PDF Eye
plot for the output of the component is identical to the upstream PDF Eye plot.
For example, if computing the PDF Eye plot for the output of the Channel
function, but the Channel function is not inserted into the signal path, the PDF
Eye plot will be identical to the PDF Eye plot of the output of the Filter function.

SP In The SP In PDF Eye is a color graded Probability Density Function representing
the eye pattern at the transmission side of the signal path. It is constructed
from the convolution of the Correlated Eye with uncorrelated jitter and noise
probability distributions.

SP Filter 2 The SP Filter PDF Eye is a color graded Probability Density Function
representing the eye pattern at the output of the filter if the filter function
is inserted in the signal path. It is constructed from the convolution of the
Correlated Eye with uncorrelated jitter and noise probability distributions.

SP Channel 2 The SP Channel PDF Eye is a color graded Probability Density Function
representing the eye pattern at the output of the channel emulator if the
Channel function is inserted in the signal path. It is constructed from the
convolution of the Correlated Eye with uncorrelated jitter and noise probability
distributions.

PDF Eyes

SP Equalizer 2 The SP Equalizer PDF Eye is a color graded Probability Density Function
representing the eye pattern at the output of the Equalizer if the Equalizer
function is inserted in the signal path. It is constructed from the convolution of
the Correlated Eye with uncorrelated jitter and noise probability distributions.

This selection was displayed as PDF Eye in 80SJNB application versions
before version 2.1.

BER Eye 1 The BER Eye is a three-dimensional color graded map representing the
predicted bit error rates at all decision thresholds and sampling phases in the
unit bit interval.
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Eye plots Description

Q Eye 1 The Q Eye is a three-dimensional color graded map representing the predicted
bit error rates at all decision thresholds and sampling phases in the unit bit
interval with a linearized Q-scale, rather than the BER logarithmic scale.

BER Contour 1 The BER Contours show the boundaries of the eye opening at the projected
bit error levels.

xxx

1 Eye plot is computed at the end of the signal path, regardless of using the 80SJNB Advanced or Essentials version.
2 Tthe 80SJNB Advanced version (with Signal Path emulator) provides PDF Eye plots at the various stages (functions) of the emulator. If the function

is not inserted, the PDF Eye plot is identical to the upstream plot.
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Noise Plots
Noise plots Description

DDN vs Bit 1 Data Dependent Noise versus Bit displays the data levels sampled at the user
specified Sampling Phase through the entire pattern. The pattern itself is shown in
the background for cross reference. If the pattern is very long, the pattern bits are
visible only when opening the graph with Examine.

RN*PN PDF Random and Periodic Noise Probability Density Function is the histogram of the
uncorrelated noise distribution on data acquired on a single flat spot of logic level 1
of the bit stream.

RN PDF Random Noise Probability Density Function shows the Gaussian distribution of
the random, unbounded, uncorrelated noise component. It is computed from data
acquired on a single flat spot of logic level 1 of the bit stream.

PN PDF Periodic Noise Probability Density Function represents the histogram of the
uncorrelated, bounded, periodic noise component. It is computed by spectral
separation of the noise data acquired on a single flat spot of logic level 1 of the
data stream.

DN PDF Deterministic Noise Probability Density Function shows the distribution of the
bounded noise component. The histogram is computed by convolving the DDN PDF
with the PN PDF.

DDN PDF Data Dependent Noise Probability Density Function is the histogram of the data
pattern correlated noise distribution on both logic levels 1 and 0. It includes the data
levels at all user specified unit bit interval Sampling Phase.

TN PDF Total Noise Probability Density Function represents the computed histogram derived
from all noise components, correlated and uncorrelated, bounded and unbounded.
The convolution of DN PDF and RN PDF yields the Total Noise histogram.

RN*PN Spectrum 1 Random and Periodic Noise Spectrum represents the spectral distribution of the
uncorrelated noise acquired on a single flat spot of logic level 1. The spurs represent
the periodic noise spectral lines, and the rest of the evenly distributed spectral lines
compose the random noise spectrum.

DDN Spectrum 1 The Data Dependent Noise Spectrum is the result of the time domain to frequency
domain transformation of the series of level samples taken on all bits at the user
specified Sampling Phase of the unit bit interval.

BER Bathtub The BER Bathtub curve is computed as a vertical slice of the 3-dimensional BER Eye
at the user specified unit bit interval Sampling Phase. It represents the extrapolated
total noise and vertical eye opening limits at projected bit error rates.

Q Bathtub The Q-scaled curve is a linearized scale version of the BER Bathtub curves. It
represents the extrapolated total noise and vertical eye opening limits at projected
bit error rates.

xxx

1 The zoom feature defaults to horizontal zoom only.
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Pattern Plots

Pattern plots can be computed at various stages of the signal path emulator when using the 80SJNB
Advanced version. When using the Essentials version of the 80SJNB, all Pattern plots are identical.

If a signal path component is not inserted into the signal path, the plot for the output of the component is
identical to the upstream plot. For example, if computing the pattern plot for the output of the Channel
function, but the Channel function is not inserted into the signal path, the pattern plot will be identical to
the pattern plot of the output of the Filter function.

Pattern plots Description

SP_In 1 The Signal Path Input signal plots the correlated pattern at the transmission side
of the Signal Path, the input to the simulated serial link. The correlated pattern
results when the acquired pattern is filtered for the removal of the uncorrelated jitter
and noise components. For closer examination of the pattern, use Examine which
provides pan and zoom capabilities, and data cursors.

SP_Filter 1 The Signal Path Filter output plots the correlated pattern at the output of Filter, if the
Filter function is inserted in the signal path. The selected Filter file determines the
effects of the Filter function on the waveform. If the Filter function is not inserted in
the signal path, The SP_Filter displays the upstream waveform, in this case SP_In.

SP_Channel 1 The Signal Path Channel output plots the correlated pattern at the output of the
Channel emulator if the Channel function is inserted in the signal path. The selected
S-parameter or time domain waveform set determines the attributes of the signal at
the output of Channel. If the Channel function is not inserted in the signal path,
SP_Channel displays the upstream waveform which could be the SP_Filter or SP_In
function of signal path configuration.

SP_Equalizer 1 The Signal Path Equalizer output plots the correlated pattern at the output of the
Equalizer if the Equalizer function is inserted in the signal path. The configuration of
tap numbers and tap values determines the attributes of the equalizer and shapes
the signal at the output. If the Equalizer function is not inserted, SP_Equalizer plot
displays the upstream signal which could be any of the previous patterns, depending
on the signal path configuration.

xxx

1 The zoom feature defaults to horizontal zoom only.

SSC Plot
SSC plot Description

SSC Profile 1 The Spread Spectrum Clocking profile displays the function used for modulating
the serial link clock frequency. If the “SSC is present” check box is checked in the
Acquisition setup dialog, the profile plot is displayed.

xxx

1 The zoom feature defaults to horizontal zoom only.
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Working with Numeric Results

After an analysis is complete, you can display the results as numeric data in either a summary or detailed
(full) table. Use the View menu in the file menu bar to select how to display the data. A summary of data
allows room to display the plots while the full results replaces the plot display entirely.

TIP. Using a second monitor (connected to the TekScope) to display the 80SJNB application allows the
numeric results display to show all results at once.

There are two views of the summary table: SSC and Signal Path. Both summary selections contain the
noise and jitter measurements but not the breakdown of the measurements. The two summaries differ by
displaying relevant application settings.

The detailed table (when selected) expands to fill the entire screen, removing any plot displays.
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You can easily switch between summary and detailed numeric displays by clicking the numeric results

button and the plot window buttons .

To hide the summary table and provide more room for the plot displays, click the numeric data table tab.
Click the tab again to show the summary data table.

Here you can see that the plot windows fill the entire screen and the tab for the numeric details is showing
at the bottom of the screen.
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See Also:

Working with Plots (see page 52)

Noise Measurement Definitions (see page 48)

Jitter Measurement Definitions (see page 47)

Dual Dirac Measurement Definitions (see page 47)

SSC Modulation Measurement Definitions (see page 48)

An Application Example

The following example uses the 80SJNB application on an optical signal for fast analysis of BER, Jitter,
and Noise. This simplified application example shows how to configure and use the application. This may
help you when setting up your own test situation.

Requirements:

DSA8300 oscilloscope

80SJNB software

ADVTRIG Advanced Trigger Option installed

Optical module with clock recovery. The following example uses the 80C11-CR4 Optical Sampling
Module.

SMA cables

Set Up the Oscilloscope

1. Install the modules and make the signal connections (the example assumes using channel 1 as the
signal source).

2. Turn on the instrument and wait for instrument and application startup to complete.

3. Push the Default Setup front panel button.

4. Select Channel 1.

5. Push the SETUP DIALOGS button.

6. Click the Horz tab.

7. Set the Horizontal scale to 5 ns.

8. Click the Mode/Trigger tab.
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9. Verify that Trigger Source is set to Clock and select C1 Clock Recovery as the clock source.

10. Click the Pattern button in the Scope Mode (Clock Trigger Source) area.

11. Click the Pattern Sync/FrameScan Setup button.

12. Enter the Data Rate parameter (for example, 9.8 Gbps).

13. Set the Pattern Length parameter (for example, 127 bits).

14. Click Close.
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NOTE. You should now have a stable signal display on the DSA8300. If not, recheck all settings, signal
source, and connections. The 80SJNB application requires a stable signal to acquire data for accurate
measurements.

Set Up the 80SJNB Application

1. Click Applications > 80SJNB in the DSA8300 menu to start the 80SJNB application.

You can also use the Windows 80SJNB desktop shortcut or the Windows Start menu Start > Programs >
Tektronix Applications > 80SJNB > 80SJNB to start the 80SJNB application.

1. Wait for the 80SJNB application to finish loading.

2. Click the Acquisition button ( ) to open the acquisition dialog box.

3. Most of the configuration settings are already filled in, as the 80SJNB application acquired the values
from the oscilloscope configuration. If not, click the AutoSync to Selected Waveform button to sync
the Source, Data Pattern, and Pattern Sync settings to the oscilloscope.

Since this is an optical signal and we’re using the clock recovery signal, you’ll need to select the
optical signal filter and select the clock recovery settings.

The setup in this example does not include a Phase Reference module, so set this to None.

Click OK to apply the settings and close the dialog box.
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4. Click to start the acquisition and processing cycle.

While the cycle is running, you’ll see the sequence of events displayed at the bottom of the application
display. When the cycle is complete, the application displays the message “Analysis Complete.”

5. Once the cycle is complete, you’ll see the displayed results. The example below shows a four plot
display with the summary table of the numerical results.

Working with the Results

1. Click to minimize the plot displays and show the detailed results table.
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2. Redisplay the plot (or plots) by selecting one of the plot display buttons .

Click the Results tab to minimize the detailed list to a summary list.

3. With the plots now redisplayed, click the Configure Plot icon ( ) on the plot tab to display a
drop-down menu for that plot. The menu provides several functions, one of which is to select a
different type of plot to display in that window.
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You can select any plot type. The plot is displayed based on the data based on the results of the
last processing cycle.

4. To further examine a plot, you can display any plot in a MATLAB window, providing you with more

tools to work with the data. Click the Configure Plot ( ) icon and choose Examine.

The plot opens in a new window to provide further data analysis and visualization of the plot displays.

MATLAB provides multiple capabilities to display and annotate the plot diagrams, including:

Pan and Zoom

2D and 3D visualization

Rotation

Data Cursors

Color enhancements

The following figure shows a 3D BER Eye plot using the rotate function.

Close the window to return to the 80SJNB display.

This is the end of the example. You can continue on by acquiring new data, displaying various types of
plots, and examine the plots with the various tools available.
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About Application Parameters

These topics list the 80SJNB application parameters and include the menu default settings. The parameter
tables list the selections and startup values for each option.

Analysis Settings (see page 71)

Acquisition Settings (see page 72)

Signal Path Settings (see page 73)

Refer to the GPIB topics for a list of the GPIB Command Syntax with the arguments, variables, and
variable values that correspond to the 80SJNB parameters.

You should refer to the documentation for your TekScope for operating details of the oscilloscope controls.

See Also:

GPIB Reference Materials (see page 75)

Analysis Settings

This table lists the default values of the Analysis settings when the 80SJNB application is first started. If
you change these settings, they remain in effect for all successive sessions of the application.

Control Startup settings

Method Spectral + BUJ

Decision Threshold Normalized: 50%

Time Unit Seconds

Sampling Phase Unit Intervals: 0 UI

Measurement BER 1.00E-12

xxx
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Acquisition Settings

This table lists the default status of the Acquisition settings when the 80SJNB application is first started. If
you change these settings, they remain in effect for all successive sessions of the application.

Control Startup settings

Signal

Source First valid input channel

SSC is present Checked

Difference Waveform

Positive First valid input channel

Negative blank

Data Pattern

Rate User defined

Pattern Length User defined

Stop on Condition Never

Scope Setup Recall On Exit Checked

Signal Conditioning

Wavelength None

Filter None

Bandwidth blank

Pattern Clock

Source CLOCK INPUT/PRESCALE TRIGGER front panel
connector

Recovery Rate blank

Phase Reference

Source None

Frequency blank

xxx
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Signal Path Settings

This table lists the default status of the Signal Path settings when the 80SJNB application is first started. If
you change these settings, they remain in effect for all successive sessions of the application.

Control Startup settings

Filter

Uncorrelated Scaling 1.00

Channel

Data Type Frequency Domain

Uncorrelated Scaling 1.00

Equalizer

Taps

FFE Taps 1

FFE Taps/Symbol 1

DFE Taps 0

Filter

FFE Reference Tap 1

Uncorrelated Scaling 1.00

Rise Time Selector Track Data Rate

User Rise Time (ps) 200

xxx
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Remote Control Introduction

The 80SJNB software application can be controlled programmatically through the programmatic interface
of the sampling oscilloscope on which it is running. Communication with the application is accomplished
using VARIABLE:VALUE remote GPIB commands.

Your program should comply with the following guidelines:

The application startup must complete before sending additional GPIB commands to the application.
Querying the variable “Application” returns “80SJNB” when the application startup is complete.

The measurements cycle must complete before you query data. Querying the variable DataReady
returns “True” when the data is ready.

Because the oscilloscope software hosts the GPIB interface for the 80SJNB application, there is some
additional information that is helpful for successful programming.

See Also:

GPIB Reference Materials (see page 75)

Programming Tips (see page 76)

Variable:Value Commands (see page 77)

Results Queries (see page 84)

Programming Examples (see page 86)

GPIB Reference Materials

To use GPIB commands with your TekScope, you can refer to the following materials:

The Programming Examples (see page 86) topic for guidelines to use while designing a GPIB program.

The online Programmer Guide for the TekScope.

See Also:

Starting and Setting Up the Application Using GPIB (see page 75)
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Programming Tips

How the Variable Value Table Works

Programmable Interface (PI) commands for the 80SJNB software package (JNB) are implemented using
a variable/value table. This table associates named variables with text values. These values can be set
(variable:value “VariableName”,”VariableValue”) or queried (variable:value? “VariableName”) from the
PI. When a set command is received, if the variable does not already exist in the table, it is created and the
specified value is associated with that variable. If the variable is already in the table, the specified value
will replace the existing value. There is no checking done by the table on variable names or values. Since
both items are strings, any arbitrary pair of strings can be associated with each other in this table.

Polling and Limit of Variable Values

Each time a change is made to a variable’s value in the table, an event is generated. The 80SJNB software
application polls the oscilloscope software application every 200 ms to see if an event occurred. If so, JNB
queries for the event information which tells JNB which variable changed and the new value. JNB parses
this information to find the variables pertinent to its operation and reads the new values for those variables.
These new values can change the state of JNB (for example selecting a new data source channel) or can
cause JNB to perform an operation (for example, setting “SequencerMode” to “Run”).

Because JNB polls for changes at a fixed rate, the oscilloscope application might indicate that a list of
variables has changed since the last time JNB polled for changes. There are two consequences of this
operation.

First, when JNB receives a list of changes, it does not necessarily execute those changes in the order in
which they were sent to the oscilloscope from the PI. This means that sending a command to change
the data source (for example, “DataSource”,”C1”) followed immediately by starting sequencing
(“SequencerState”,”Run”) does not guarantee that the source channel is changed before JNB begins
the sequencing operation. To be sure of proper execution order of these commands, a delay of at least
400 ms should be inserted before starting certain JNB operations.

Commands that should be preceded by a delay include:

“SequencerState”,”Run”

“ExportCurve”,”GO”

“SaveRecallData”,”Save”

“SaveRecallData”,”Recall”

“Setup”,”Save”

“Setup”,”Recall”

Second, there is a limit of 15 variable/value table changes that can be reported for any one polling
event. If more than 15 changes have occurred between JNB polls of the oscilloscope software, the
later changes will not be seen by JNB so it will not respond to those commands.

76 80SJNB Printable Online Help



Remote Control Syntax

How the Variable Value Table Is Updated

JNB only updates table entries when it has new data to report. For example, if an error occurs during
sequencing, the variables “ErrorCode” and “ErrorMessage” are updated by JNB with the appropriate
values. However, JNB will only update those variables if another error occurs. If a subsequent sequence is
run without errors, the “ErrorCode” and “ErrorMessage” variables will continue to report the old values.
The user program must be written to explicitly clear these variables, setting the variables to null strings
(“”) before starting a new sequence.

Variables that should be set to null strings (“”) before starting a sequence operation include:

ErrorCode

ErrorMessage

DataReady

Determining If 80SJNB Is Running

The “Application” variable shows whether 80SJNB is running or not. When it is running, this variable is
set to “80SJNB”. When JNB exits normally, the variable is set to “Done”. However, if JNB encounters an
error and exits abnormally, it will not set the “Application” variable to “Done”, leaving the variable set
to “80SJNB”. In this circumstance, it is not possible to use this variable to determine if JNB is running.
One way to reliably determine if JNB is running is to set the “PatternLength” variable to “1”. If JNB is
running, it will set this variable to “2” since 2 is the minimum allowable value for “PatternLength”. If JNB
is not running, the variable value will remain at “1”. Be sure to wait at least 400 ms after setting the value
to “1” before querying the status of this variable.

Syntax

The VARIABLE:VALUE command accepts string arguments for a control or data variable and a value
to which to set the argument.

To set a variable to a value:

VARIABLE:VALUE "<VariableName>","<VariableValue>"

NOTE. The arguments <variable name> and <variable value> are required in the order indicated with no
spaces allowed.

To query the value in a variable:

VARIABLE:VALUE? <variable name>

NOTE. Commands are case and space sensitive. Your program will not operate correctly if you do not
follow the capitalization and spacing precisely.
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See Also:

Variable:Value Command Arguments and Queries (see page 78)

GPIB Commands Error Codes (see page 86)

Programming Examples (see page 86)

Arguments and Queries
Name Value Function Query form returns

AcqCycleCount Positive integer number
larger than 2

Sets or returns the
acquisition cycle count

Current value

AnalysisMethod {CDF | Spectral} Sets the jitter and noise
analysis method. Spectral
is legacy. Default is CDF
(Cumulative Distribution
Function)

Current value

Application Exit Exits the application Done

Bandwidth Any valid bandwidth as
defined by the selected
source module

Sets or returns the
bandwidth in Hertz for
use when Filter is set to
None

Current value

BER Any valid floating point
value between 1e-3 and
1e-24 inclusive

Sets or returns the current
BER value

Current value

CeActive {True | False} Activates or deactivates
the channel emulator

True, False

CeDomain Time | Frequency Sets the domain in which
the channel characteristics
are defined

Current value

CeFdSParametersFile Full path name of a file
name

Defines the channel’s
S-parameter

Current value

CeFd2PortMatrixSelector {11 | 12 | 21 | 22} Selects an S-parameter
when using a 2-port
Touchstone file

Current value

CeFd4PortDataType {SingleEnded | Differential} Selects the type of data
when using a 4-port
Touchstone file

Current value

CeFd4PortLayout {DC21 | CD21 | 12DC |
12CD}

Sets the data arrangement
used by a 4-port
Touchstone file containing
Differential data

Current value

CeFd4PortMapping Any permutation of 1234
(for example, 1234, 1324
or 2143)

Sets the port mapping used
by a 4-port Touchstone file
containing SingleEnded
data

Current value
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Name Value Function Query form returns

CeTdReferenceFile Full path name of a file
name

Defines the time domain
reference waveform

Current value

CeTdTransmissionFile Full path name of a file
name

Defines the time domain
transmission waveform

Current value

CeUncorrelatedScaling Any number in the range
0.01-100.0

Sets the Channel
uncorrelated scaling factor

Overall signal path
uncorrelated scaling factor
is a product of all active
uncorrelated scaling values

Current value

ClockRecoveryRate Valid values include any
communication standard
token for communication
standards supported by
the clock recovery module
or a positive floating point
value if the clock recovery
unit supports user rates

Sets or returns the clock
recovery rate

Current value

ClockSource {ClockPrescale |
C1ClockRecovery |
C1CRClockPrescale
| C3ClockRecovery |
C3CRClockPrescale}

Sets or returns the clock
source

Current value

DataRate Any valid positive
floating point value or
communication standard

Sets or returns the
expected data rate

Communication standard
or current value

DataReady {True | False} Sets or returns a value
indicating if sequencing is
complete and data is ready
to be read

Setting this value to
False before beginning
a sequence prevents
accidentally reading the
DataReady value from a
previous sequence before
it is reset by the application

True, False

DataSource {CH1 | CH2 | CH3 | CH4 |
CH5 | CH6 | CH7 | CH8 |
MATH1 | MATH2 | MATH3 |
MATH4 | MATH5 | MATH6
| MATH7 | MATH8 | <file
name >}

Sets or returns the data
source

Math expressions must
be programmed through
the oscilloscope GPIB
interface commands

Current value

file name is the name of the
file recalled

DecisionThresholdAbs Any valid floating point
value

Sets or returns the absolute
decision threshold value

Current value

DecisionThresholdPct Any valid floating point
value between 0.0 and
1.0 inclusive

Sets or returns the
normalized decision
threshold value

Current value
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Name Value Function Query form returns

DecisionThresholdUnits {Absolute, Normalized} Sets or returns the desired
decision threshold value to
use

By setting the units
to Absolute, the
DecisionThresholdAbs
value is used. If the units
are set to Normalized,
the decision threshold
is calculated based on
waveform data according to
the DecisionThresholdPct
normalized value.

Current value

EqActive {True | False} Activates or deactivate the
equalizer

True or False

EqAutosetTaps {Run} Automatically computes
the equalization
coefficients

SpCompute must be run
first

Current value or Done,
Error

EqDFETaps An integer in the range
1-40

Sets the number of DFE
taps

Current value

EqDFETapCoefficient<n>
where <n> is in the range
1–40

Any number in the range
-100.0 to +100.0

Sets the value of a DFE tap
coefficient

Current value

EqDefaultDFETaps 2 {Run} Sets the DFE taps to
default values

Current value or Done,
Error

EqDefaultFFETaps 2 {Run} Sets the FFE taps to default
values

Current value or Done,
Error

EqFFEReferenceTap An integer in the range 1 –
EqFFETaps

Selects the FFE reference
tap

EqFFEReferenc-
eTap-1 must be an integer
(possibly 0) multiple of
EqFFETapsPerSymbol

Current value

EqFFETaps An integer in the range
1-100

Sets the number of FFE
taps

Current value

EqFFETapsPerSymbol One of 1, 2, 5, 10 but not
larger then EqFFETaps

Sets the number of FFE
taps per symbol or unit
interval

Current value

EqFFETapCoefficient<n>
where <n> is in the range
1–100

Any number in the range
-100.0 to +100.0

Sets the value of an FFE
tap coefficient

Current value

EqLoadTaps 2 {Run} Loads the equalizer
configuration from a file

Current value or Done,
Error

EqRiseTimeSelector {DataRate | TapInterval |
User}

Defines how the equalizer
rise time is determined

Current value
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Name Value Function Query form returns

EqSaveTaps 2 {Run} Saves the equalizer
configuration to a file

Current value or Done,
Error

EqTapsFilename Full path name of a file Sets the file used
for EqLoadTaps and
EqSaveTaps

Current value

EqUncorrelatedScaling Any number in the range
0.01-100.0

Sets the Equalizer
uncorrelated scaling factor

Overall signal path
uncorrelated scaling factor
is a product of all active
uncorrelated scaling values

Current value

EqUserRiseTime An integer in the range
1-4000

When EqRiseTimeSelector
is set to User, this defines
the rise time in picoseconds

Current value

ErrorCode Returns a numeric code
corresponding to the last
error or 0 if no error

Current value

ErrorMessage Returns the last error
message

Current value

ExportCurve 2 3 {GO} Sets or returns the export
action

Current value or Done,
Error

Error is returned if export is
unsuccessful

ExportFilename <file name > 1 Sets the file name used
when exporting data

ExportFormat {CSV, MAT} Sets or returns the current
plot diagram export format

Current value

ExportResults {GO} Initiates the export results
action to the file specified
by ExportFilename

Export action status: Done
or Error
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Name Value Function Query form returns

ExportType ACQWFM | CORRWFM,
RJPDF | PJPDF |
RJPJPDF | RJPJSPEC
| DDJPDF | DJPDF |
DDJSPEC | TJPDF |
DDJ | HBATH | QHBATH
| RNPDF | PNPDF |
RNPNPDF | RNPNSPEC
| DDNPDF | DNPDF |
DDNSPEC | TNPDF |
DDN | VBATH | QVBATH
| BEREYE | QEYE |
PDFEYE | CORREYE
| BERCONTOUR |
SPCHANPDFEYE
| SPCHANWFM
| SPFILTWFM |
SPFILTPDFEYE
| SPINPDFEYE |
SPINWFM | SPEQWFM |
SSCPROFILE

Sets or returns the type of
export to perform

Current value

FiActive {True | False} Activates or deactivates
the filter

True, False

FiFilename Full path name of a file
name

Defines the filter file Current value

FiUncorrelatedScaling Any number in the range
0.01-100.0

Sets the Filter uncorrelated
scaling factor

Overall signal path
uncorrelated scaling factor
is a product of all active
uncorrelated scaling values

Current value

Filter Any valid communication
standard as defined by the
selected source module

Sets or returns the
communication standard of
the source

Current value

PatternLength Any integer value between
2 and 100,000

Sets or returns the data
pattern length in bits

Current value

PhaseReferenceEnabled Indicates whether the data
was acquired with a phase
reference unit active or
not for both acquired and
recalled data

True, False

PhaseReferenceFrequency Any valid phase reference
frequency as defined by the
selected phase reference
source module

Sets or returns the phase
reference frequency

Current value
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Name Value Function Query form returns

PhaseReferenceSource {C1C2 -or- C1_C2,
C3C4 -or- C3_C4,
C5C6 -or- C5_C6,
C7C8 -or- C7_C8}

Sets or returns the phase
reference source module

Current value

RecallDataFilename <file name > 1 Specifies the name of the
file when recalling a saved
data file

RecallFilename <file name > 1 Sets the name of the file
when recalling a setup

SamplingPhase Any valid floating point
value between –0.5 and
+0.5 inclusive

Sets or returns the
normalized sampling
point value

Current value

SamplingPhaseAbs Any valid floating point
value

Sets or returns the absolute
sampling point value

Current value

SamplingPhaseUnits {Absolute, Normalized} Sets or returns the desired
sampling point value to
use.

If the units are set
to Absolute, the
SamplingPhaseAbs value
is used. If the units
are set to Normalized,
the sampling point is
calculated based on
waveform data according
to the SamplingPhase
normalized value.

Current value

SaveDataFilename <file name > 1 Sets the file name used
when saving data files

SaveFilename <file name > 1 Sets the file name used
when saving setup files

SaveRecallData 3 {Save, Recall} Save saves the acquired
data to the file name
specified by the command
SaveDataFilename

Recall recalls the acquired
data from the file name
specified by the command
RecallDataFilename

Done, Error

Error is returned if
unsuccessful

ScopeSettingRecall {True | False} Sets or returns the option
of recalling scope setup
stored when starting the
application

Current value

SequencerMode {SingleSequence,
FreeRun}

Sets the sequencer mode

Startup default is Free Run

Sequencer mode
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Name Value Function Query form returns

SequencerState 3 {Run | Pause | Stop} Sets or returns the
Measurement Sequencing
or the Stop Sequencing
command

Sequencer state

Setup 3 {Recall | Save | Default} Performs the
Save/Recall/Default setup
action

Current value or Done,
Error

Error is returned if
unsuccessful

SpCompute 2 {Run} Recomputes results with
the latest Signal Path
definition on the acquired
data

Current value or Done,
Error

SSC {True | False} Selects whether SSC is
present in the signal

Setting to True requires a
phase reference module to
be installed and configured

Current value

StopOnCondition {Never | AcqCycle
| UncorrCount |
TotalPopulation}

Sets or returns the selected
Stop on Condition when in
Free Run

Current value

TimeUnits {S | UI} Sets or returns the units for
the time scale

S, UI

TotalPopCount Positive integer number Sets or returns the total
sample count

Current value

UncorrCount Positive integer number Sets or returns the
uncorrelated sample count

Current value

WLength Any valid wavelength as
defined by the selected
source module

Sets or returns the
wavelength of the sources

Current value

xxx

1 <file name > is a string of 1 to 40 characters that are valid for file names according to the Windows file system standards.
2 After running the default setup command, this argument is not initialized and a query returns an empty string "".
3 Command should be preceded by a delay of at least 400 ms.

Variable:Value Results Queries

These values, when used with the Variable:Value command, return the results for the individual
measurement results.

Value Function

BUJDD Returns the Bounded Uncorrelated Jitter

BUNDD Returns the Bounded Uncorrelated noise.

DCD abc Returns the Duty Cycle Distortion.

DDJ Returns the Data Dependent Jitter.
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Value Function

DDN Returns the Data Dependent Noise.

DDN0 Returns the Data Dependent Noise on logical level 0.

DDN1 Returns the Data Dependent Noise on logical level 1.

DDPWS Returns the measured Data Dependent Pulse Width Shrinkage.

DJ Returns the measured deterministic jitter.

DJDD Returns the Deterministic Jitter computed in the Dual Dirac model.

DN Returns the measured deterministic noise.

EA Returns the amplitude of the eye computed as the mean-to-mean of logical 1 and
logical 0 bit levels sampled at the user defined Sampling Phase.

EOH Returns the Horizontal Eye Opening at user specified BER.

EOV Returns the Eye Opening at user-specified BER.

NPJDD Returns non periodic jitter

NPNDD Returns non periodic noise

PJ Returns the measured Periodic Jitter (peak-to-peak).

PJH Returns the Horizontal component of periodic jitter (peak-to-peak).

PJV Returns the Vertical component of periodic jitter (peak-to-peak) induced by noise
converted to jitter through an average slew rate.

PN Returns the measured periodic noise.

PNH Returns the Horizontal component of periodic noise (peak-to-peak) induced by jitter
converted to noise through an average slew rate.

PNV Returns the Vertical component of periodic noise (peak-to-peak).

RJ Returns the measured random jitter (RMS).

RJH Returns the Horizontal component of random jitter (RMS).

RJV Returns the Vertical component of random jitter induced by noise converted to jitter
through an average slew rate (RMS).

RJDD Returns the Random Jitter computed in the Dual Dirac model.

RN Returns the measured Random Noise.

RNV Returns the Vertical component of random noise.

RNH Returns the Horizontal component of random noise induced by jitter converted to
noise through an average slew rate.

SampleCount Returns the total sample count acquired and processed while running.

TJ Returns the Total Jitter at user-specified BER.

TN Returns the Total Noise at user-specified BER.

SSCfreq Returns the spread spectrum clock modulation frequency.

SSCmag Returns the spread spectrum clock modulation magnitude.

xxx

80SJNB Printable Online Help 85



Remote Control GPIB Commands Error Codes

GPIB Commands Error Codes

Error code Description

–1 Read error message, no error code available

NOTE. If an error code of –1 is returned, use the Error Message query for error
condition details.

1 The channel does not support bandwidth

2 Phase characterization failed

3 No data to export

4 Not allowed to change setting while sequencing

5 Invalid value

6 Argument cannot be null

7 Value is outside the range of acceptable values

8 Query curve returned no data

9 Unexpected GPIB response

10 No data source selected

11 One or more WfmDBs are on; turn them off to continue

12 Trigger failure, check your configuration

13 The pattern is not synchronized or is too small

14 Cannot export the curve

15 Could not analyze edge

16 Histogram testing is on; turn it off to continue

17 Mask testing is on; turn it off to continue

18 One or more measurements are on; turn them off to continue

19 Waveforms other than 80SJNB signal source are on; turn them off to continue

20 Save setup failed

21 Recall setup failed

22 The channel does not support wavelength

23 Curve has multiple components

24 A Mag View is on; turn it off to continue

25 SSC activation failed; phase reference module required

26 SSC activation failed; setup phase reference module

27 Save data failed

28 Recall data failed

xxx

Programming Examples Introduction

An example of communicating with the 80SJNB application using VARIABLE:VALUE remote GPIB
commands is to simply start the application by sending the following command:
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APPlication:ACTivate "80SJNB"

A more extensive program example steps you through the following actions:

1. Starting the application.

2. Configuration and setting analysis state variables.

3. Starting and checking the state of the acquisition and processing cycle.

4. Check for errors.

5. Query measurement results.

6. Export data.

Program Examples:

Configure and Operate the 80SJNB (see page 87)

Measuring Jitter in Presence of SSC (see page 89)

Compensating for Signal Path Impairments with Equalization (see page 91)

See Also:

About the GPIB Program and Guidelines (see page 75)

GPIB Reference Materials (see page 75)

Variable:Value Command (see page 77)

Results Queries (see page 84)

Program Example: Configure and Operate 80SJNB

The following sequence of commands shows the GPIB commands used to configure and operate the
80SJNB jitter analysis application. All commands are sent to the instrument which hosts the programmable
interface for the 80SJNB.

NOTE. The examples presume that you are familiar with designing GPIB programs.

All words within quotes are case sensitive and must be entered exactly as shown, including spaces and
quotes.

1. Send the command to start the 80SJNB application.

APPLICATION:ACTIVATE "80SJNB"

2. Set the signal source channel, data rate, and pattern length to be analyzed.
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VARIABLE:VALUE "DataSource","CH1"

VARIABLE:VALUE "DataRate","10.3125e9"

VARIABLE:VALUE "PatternLength","32767"

3. Set the following variables before starting the analysis. The application updates these values to signal
the application’s analysis state.

VARIABLE:VALUE "DataReady","False"

VARIABLE:VALUE "ErrorCode",""

4. Start the acquisition and processing cycle.

VARIABLE:VALUE "SequencerState","Run"

5. Check the state of the acquisition and processing cycle.

Query the following variables:

VARIABLE:VALUE? "DataReady"

VARIABLE:VALUE? "SequencerState"

Loop until DataReady is True or SequencerState is Stop.

6. Check to see if there were errors.

VARIABLE:VALUE? "ErrorCode"

If the response for ErrorCode is not 0 then an error has occurred. Query

VARIABLE:VALUE? "ErrorMessage"

to retrieve the error message.

7. If the DataReady variable is set to True (queried in step 5), you can query for measurement results.
For example to query the deterministic jitter:

VARIABLE:VALUE? "DJ"

8. You can also export the plot data. The following commands set the format, data to export, file name,
and then exports the data.

VARIABLE:VALUE "ExportFormat","CSV"

VARIABLE:VALUE "ExportType","DJPDF"

VARIABLE:VALUE "ExportFilename","C:\Users\<username>\Documents\

myDJPDF.csv"

VARIABLE:VALUE "ExportCurve","GO"

9. Query the ExportCurve variable to determine when the data export has completed:

VARIABLE:VALUE? "ExportCurve"

The application sets the ExportCurve value to "Done" when the data is exported.
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Program Examples:

Measuring Jitter in Presence of SSC (see page 89)

Compensating for Signal Path Impairments with Equalization (see page 91)

Program Example: Measuring Jitter in Presence of SSC

The following instruction sequence shows jitter analysis in the presence of SSC and the measurement of
the SSC characteristics.

NOTE. The examples presume that you are familiar with designing GPIB programs.

All words within quotes are case sensitive and must be entered exactly as shown, including spaces and
quotes.

NOTE. The measurement system configuration should include a correctly set up and configured Tektronix
BERTScope CR series instrument (clock recovery instrument, or CRI) that supports SSC.

An 82A04 Phase Reference module is required for measuring signals that contain SSC.

1. Send the command to start the 80SJNB application.

APPLICATION:ACTIVATE "80SJNB"

2. Set the signal source channel, data rate, pattern length, and data-to-clock ratio

VARIABLE:VALUE "DataSource","CH1"

VARIABLE:VALUE "DataRate","3e9"

VARIABLE:VALUE "PatternLength","127"

3. Initialize analysis state and error code.

VARIABLE:VALUE "DataReady","False"

VARIABLE:VALUE "ErrorCode",""

4. Tell 80SJNB to look for SSC.

VARIABLE:VALUE “SSC”,”True”

5. Set up the phase reference module source and frequency since it is required for SSC analysis

VARIABLE:VALUE “PhaseReferenceSource”,”C7_C8”

VARIABLE:VALUE “PhaseReferenceFrequency”,”3e9”

6. Set up the BERTScope clock recovery unit that supports SSC. Set clock frequency to 3e9. Refer to the
documentation for the BERTScope for more details.
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The following table lists recommended settings:

Data rate range
Clock recovery
frequency (CRI)

Clock recovery
output rate (CRI)

Recommended
Data:Clock ratio
(JNB)

Phase reference
frequency (JNB)

500 Mbps – 1 Gbps Data Rate * 4 Standard 1:4 Data Rate * 4

1 Gbps – 2 Gbps Data Rate * 2 Standard 1:2 Data Rate * 2

2 Gbps – 4 Gbps Data Rate Standard 1:1 Data Rate

4 Gbps – 8 Gbps Data Rate Subrate (1/2) 2:1 Data Rate/2

8 Gbps – 12.5 Gbps Data Rate Subrate (1/4) 4:1 Data Rate/4

xxx

7. Clear the error code to prepare for starting the application.

VARIABLE:VALUE "ErrorCode",""

8. Start the acquisition and processing cycle.

VARIABLE:VALUE "SequencerState","Run"

9. Check the state of the acquisition and processing cycle. Query the following variables:

VARIABLE:VALUE? "DataReady"

VARIABLE:VALUE? "SequencerState"

Loop until DataRead is True or SequencerState is Stop.

10. Check if there were errors:

VARIABLE:VALUE? “ErrorCode”

If the response for ErrorCode is not 0, then an error has occurred. Query:

VARIABLE:VALUE? “ErrorMessage”

11. If the DataReady variable is set to True, and no errors have occurred, you can query for measurement
results.

For example to query the periodic jitter and total jitter:

VARIABLE:VALUE? “PJ”

VARIABLE:VALUE? “TJ”

12. Query for SSC measurements, magnitude and frequency.

VARIABLE:VALUE? “SSCmag”

VARIABLE:VALUE? “SSCfreq”

13. You can also export the SSC profile. The following commands set the format, data to export, file
name, and then export the data.

VARIABLE:VALUE "ExportFormat","CSV"

VARIABLE:VALUE "ExportType"," SSCPROFILE "
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VARIABLE:VALUE "ExportFilename","C:\Users\<username>\Documents\

mySSCprofile.csv"

VARIABLE:VALUE "ExportCurve","GO"

14. Query the ExportCurve variable to determine when the data export has completed.

VARIABLE:VALUE? "ExportCurve"

The application sets the ExportCurve value to "Done" when the data is exported.

Program Examples:

Configure and Operate the 80SJNB (see page 87)

Compensating for Signal Path Impairments with Equalization (see page 91)

Program Example: Compensating for Signal Path Impairments with
Equalization

The following programming example shows a sequence of commands that configures the Signal Path with
a Channel emulator that causes severe ISI. Then an Equalizer is inserted and configured to compensate
for the effects of the ISI and assess the results of equalization by measuring data dependent jitter and
vertical eye opening.

NOTE. The examples presume that you are familiar with designing GPIB programs.

All words within quotes are case sensitive and must be entered exactly as shown, including spaces and
quotes.

NOTE. The 80SJNB Advanced option must be enabled. The S-parameter file is available from examples,
Sdd21.s1p, located in My Documents.

1. Send the command to start the 80SJNB application.

APPLICATION:ACTIVATE "80SJNB"

2. Set the signal source channel, data rate, pattern length, and data-to-clock ratio.

VARIABLE:VALUE "DataSource","CH1"

VARIABLE:VALUE "DataRate","9.95328e9"

VARIABLE:VALUE "PatternLength","127"

3. Initialize the analysis state and error code.

VARIABLE:VALUE "DataReady","False"
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VARIABLE:VALUE "ErrorCode",""

4. Start the acquisition and processing cycle.

VARIABLE:VALUE “SequencerState”,”Run”

5. Check the state of the acquisition and processing cycle.

Query the following variables:

VARIABLE:VALUE? "DataReady"

VARIABLE:VALUE? "SequencerState"

Loop until DataRead is True or SequencerState is Stop.

6. Check if there were errors.

VARIABLE:VALUE? “ErrorCode”

If the response for ErrorCode is not 0, then an error has occurred. Query:

VARIABLE:VALUE? “ErrorMessage”

7. If the DataReady variable is set to True and no error has occurred, you can query for measurement
results. Query the data dependent jitter and vertical eye opening:

VARIABLE:VALUE? “DDJ”

VARIABLE:VALUE? “EOV”

8. Select an S-parameter file from the examples provided, and insert the Channel emulator into the
Signal Path.

VARIABLE:VALUE “CeDomain”,”Frequency”

VARIABLE:VALUE “CeFdSParametersFile”,” C:\Users\<username>\

Documents\Sdd21.s1p”

VARIABLE:VALUE “CeActive”,”True”

9. Recompute the Signal Path and measure DDJ and vertical eye opening again.

VARIABLE:VALUE “SpCompute”,”Run”

Wait and query the recomputation state for completion. When completed, SpCompute query will
return Done, unless an error is encountered, in which case state will return Error.

VARIABLE:VALUE? “SpCompute”

VARIABLE:VALUE? “DDJ”

VARIABLE:VALUE? “EOV”

NOTE. Note the values of DDJ and EOV.
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10. Compute an optimal set of tap coefficients for a specified number of FFE and DFE taps by running
Autoset Taps.

VARIABLE:VALUE “EqFFETaps”,”20”

VARIABLE:VALUE “EqDFETaps”,”10”

VARIABLE:VALUE “EqAutosetTaps”,”Run”

Test for completion by querying the state of autoset. It will return Run before completion, then Done
or Error. If data is not recognized as a PRBS pattern, an error condition is returned.

VARIABLE:VALUE? “EqAutosetTaps”

11. Save the taps in a file.

VARIABLE:VALUE “EqTapsFilename”,”C:\Users\<user name>\Documents\myTaps.tap”

VARIABLE:VALUE “EqSaveTaps”,”Run”

Check for completion by querying:

VARIABLE:VALUE? “EqSaveTaps”

12. Insert the Equalizer in the Signal Path with the newly configured equalization taps.

VARIABLE:VALUE “EqActive”,”True”

13. Recompute the Signal Path again with the Equalizer inserted.

VARIABLE:VALUE “SpCompute”,”Run”

Wait and query the recomputation state for completion. When completed, query SpCompute until it is
not Run. Then check to see if the result is Done or Error.

VARIABLE:VALUE? “SpCompute”

14. If SpCompute query is Done, ask for measurement results.

VARIABLE:VALUE? “DDJ”

VARIABLE:VALUE? “EOV”

NOTE. Record the values of DDJ and EOV and compare with the previous two sets, looking for the
effects of the Channel and the Equalizer.

Program Examples:

Configure and Operate the 80SJNB (see page 87)

Measuring Jitter in Presence of SSC (see page 89)
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About Measurement Algorithms

Tektronix has developed a white paper detailing the algorithms used by the 80SJNB application to make
the measurements. T download the document:

1. Go to the Tektronix Web site www.tektronix.com .

2. Enter “Jitter and Noise Analysis, BER Estimation Descriptions with 80SJNB” in the Downloads
Enter Model Number field.

3. Click GO.

Test Methodology

The application performs the measurement according to the following steps:

1. Configures the oscilloscope and jitter application according to the Configuration settings and Analysis
settings.

2. Performs an Autoset.

3. Scans part of the pattern.

4. Analyzes the edge.

5. Acquires the jitter data.

6. Acquires the noise data.

7. Scans the full pattern.

8. Analyzes the acquired data.

9. Displays the results as statistics. You can also log the results or data points to a .csv file.

10. Displays the plots if selected.
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Correlation to Real-Time Oscilloscope Jitter Measurements

The methodology to take measurements on a sampling oscilloscope is quite different than the methodology
to take similar measurements on a real-time oscilloscope.

Recent correlation studies are available upon request. Please contact your Tektronix Customer Support
representative for more information. Jitter measurement and timing analysis information is available at
www.tek.com (enter jitter in the Enter Model Number field, and select Application Notes as the document
type).
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